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Welcome to ProSeries® Express Edition tax software
ProSeries Express Edition is designed for tax professionals who file 50 or more bank 
product tax returns each season. ProSeries Express offers:

● An innovative new approach to preparing income tax returns for clients requesting 
bank products

● Several bank product options including RT Checks, RTDDs, State RTs, Cash Cards, 
RALs, and RAL/RT Advances

● Unlimited e-filing for 1040 federal returns and all individual state returns

ProSeries Express saves you time by allowing you to:

● Offer the ProSeries Express Refund Infoline, a toll-free telephone number that your 
clients can call to check their tax refund or bank product status

● Quickly import your clients’ W-2s directly into the ProSeries Express program
● Use a refund monitor that tracks federal and state calculations in real time
● Check electronic filing and bank products acknowledgements in a single step
● View a client snapshot screen, color-coded data entry fields, an easy client 

questionnaire form, and more.
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Computer system requirements
Make sure that each computer on which you intend to use ProSeries Express software for 
the 2004 tax year meets or exceeds the minimum requirements for all relevant 
components.

The minimum requirements shown below should provide adequate performance on most 
computer configurations. The software may not operate as designed on systems that don’t 
meet the minimum requirements. For more information about how system requirements 
can affect the operation of ProSeries Express software, go to www.proseries.com.

Component Minimum Requirement Recommended Requirement

Computer Pentium 266 MHz or equivalent AMD 
processor

Pentium 4, 1.3 GHz or faster

Memory 128 MB RAM. More memory may be 
required if you install many products 
and have a large number of clients.

512 MB RAM or more. More memory 
normally results in improved 
performance.

Hard disk space 650 MB. More space may be required 
if you install many products and have 
a large number of clients.

2 GB or more, depending on the 
number of products you install and 
the number of clients you have.

Windows 
operating 
system

One of the following:

Windows NT (version 4.0, service pack 
6a or later)

Windows 98 (second edition)

Windows ME

One of the following:

Windows 2000 (service pack 3 or later)

Windows XP (Home or Professional 
edition)

Screen 
resolution

800 x 600 1024 x 768 or higher

Printer Hewlett-Packard LaserJet or PCL 
compatible with 1 MB of printer 
memory

Hewlett-Packard LaserJet Series 4 or 
later (or 100% compatible) with at 
least 1 MB of printer memory

Disk drive CD-ROM 6X or faster CD-ROM 12X or faster

Internet 
connection

28.8 K modem High-speed Internet connection (such 
as T-1, DSL, or cable modem) or 56 K 
modem

Internet 
Browser

Microsoft Internet Explorer 5.5, 
service pack 2 or later. (Internet 
Explorer 6.0 is installed if Internet 
Explorer 5.5, service pack 2 or later 
isn’t already installed.)

Microsoft Internet Explorer 6.0 or later

Internet 
Service 
Provider (ISP)

None required. However, an ISP is 
required for features that use the 
Internet, such as online delivery of 
products and electronic filing.

ProSeries Express software works with 
most ISPs. Contact your ISP if you 
have a specific question.
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Getting ready for the 2004 tax season
Know your responsibilities. You and your clients are responsible for correctly reporting all 
information that is required by the Internal Revenue Service or applicable state taxing 
agency, and for the accuracy of each return that you file.

Be familiar with your computer system. If you’re unfamiliar with the basic operation of 
your computer, your Microsoft Windows operating system, or your computer network (if 
applicable), read the owner’s guide for your computer, Windows help, or the network 
documentation.

Understand the ProSeries Express License Agreement. You must read and understand the 
ProSeries Express License Agreement. The ProSeries Express License Agreement appears at 
the start of the installation procedure. After the software has been installed, you can 
review the ProSeries Express License Agreement in the Help Center or the ProSeries 
Express User’s Guide. Please note the following conditions of the ProSeries Express License 
Agreement:

● You are licensing the software for use by a named entity and its employees at one 
identified location.

● You are representing to Intuit® that the firm name and address you provide is the 
primary firm name and location used in the normal course of business.
• This is the name and address under which you market yourself and your 

professional services.
• This firm name and address will appear in the “Paid Preparer” designation on tax 

returns.
● You may enter information about as many preparers as needed, provided that they all 

are employees of the firm listed at that particular address.
● Multiple preparers who operate as separate and distinct firms—even if they share 

office space—are considered to be unique and each preparer must purchase a license 
for his or her own copy of ProSeries software.

Preparing for electronic filing
If you want to file your clients’ federal returns (or first extension request forms) 
electronically, you must be able to connect to the Internet from the computer on which 
you install the ProSeries program. In addition, you must have an IRS-issued Electronic 
Filing Identification Number (EFIN). If you are new to electronic filing or no longer have a 
valid EFIN, you can apply for one online at www.irs.gov by registering for e-services and 
accessing the IRS e-file application, or you can complete Form 8633, Application to 
Participate in the IRS e-file Program.

Important: The IRS recommends that you submit your application at least 45 days prior 
to the date that you intend to begin filing returns electronically. You can find Form 8633 
and information about electronic filing at www.proseries.com. Select E-Filing, then How to 
E-File. You can also find Form 8633 and information about electronic filing at the IRS Web 
site at www.irs.gov.

Tip: If you have additional questions about electronic filing, call the IRS e-help desk toll 
free at 1-866-255-0654.
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State enrollment requirements
Some states require additional electronic filing enrollment paperwork. Verify the electronic 
filing enrollment requirements for each state where you plan to file returns electronically. 
You can link to each state taxing agency’s Web site at www.proseries.com/statelinks.

Preparing to offer bank products
When you file your clients’ individual returns electronically, they can receive 
disbursements based on their expected federal refunds in the form of RAL/RT Advances, 
Refund Anticipation Loans (RALs), Refund Transfers (RTs), and Refund Transfer Direct 
Deposits (RTDDs). Your clients also can receive disbursements based on their expected state 
refunds in the form of Refund Transfers (RTs). In addition, your fees are deducted from the 
client’s refund and deposited into your bank account electronically.

Before you can offer bank products to your clients, you must first apply to Santa Barbara 
Bank & Trust, Republic Bank, or First Security Bank to participate in their banking 
products program. Go to the Bank Products section of ProSeries.com to learn how to 
register.

For more information about bank products, see “Overview of Bank Products” on page 45.

Preparing to accept major credit cards and eChecks
You can use the ProSeries/Merchant Account Service to accept payment for your services 
by major credit cards and eChecks. If you aren’t already a ProSeries/Merchant Account 
Service customer, you must apply for the ProSeries/Merchant Account Service program. To 
apply, go to www.proseries.com, select Products, select Services, then select ProSeries/
Merchant Account Services.

Tip: To apply for the ProSeries/Merchant Account Service program, go to the Tools menu, 
choose Accept Credit Cards/eChecks, then choose Sign Up.

Ordering presentation folders and envelopes
To purchase presentation folders and window envelopes, call Professional Tax Products at 
1-888-236-8137, or go to the Professional Tax Products Web site at 
www.proseriessupplies.com.

Preparing to set up ProSeries Express
You can use each ProSeries Express tax product and electronic filing product on an 
unlimited basis.

Unlimited basis. When you use a tax product or electronic filing product on an unlimited 
basis, you pay a fixed fee to purchase that product, but you don’t pay a fee to print or 
convert returns for electronic filing (tax product), or to file returns electronically (electronic 
filing product).

Pay-Per-Return basis. When you use a tax product or electronic filing product on a 
pay-per-return basis, you don’t pay a fee to purchase that product, but you must authorize 
payment for each return before you can print it or convert it for electronic filing (tax 
product), or before you can file it electronically (electronic filing product).

Note that service and delivery fees are separate from product purchase fees.
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When you purchase ProSeries Express software, you can prepare the following types of 
returns on an Unlimited basis: 1040, 1120, 1120S, 1065, 1041, and 990 federal returns, 
individual state returns for the states that you select, and business state returns for the 
states that you select. In addition, you can file individual returns electronically on an 
Unlimited basis. If you want to prepare 706 or 709 federal returns, you can prepare these 
returns on a Pay-Per-Return basis.

Important: If you want to use a ProSeries Express product on an unlimited basis, 
purchase the Unlimited version of that product before you install ProSeries Express tax 
products. To order the Unlimited version of a ProSeries Express product, call ProSeries 
Express Sales at 1-800-934-1040 or order online at www.proseries.com. The product 
information in your customer record will be updated. Product licensing can be done 
automatically if your computer is connected to the Internet (which is the recommended 
method), or you can use the manual method for product licensing.

When you install ProSeries Express software, you’ll select the tax products that you want 
to install. If you haven’t already purchased the Unlimited version of a tax product or 
corresponding electronic filing product, the Pay-Per-Return version of that product will be 
installed.

You will be prompted for information about the following topics while you’re setting up 
ProSeries Express. (You can enter this information later as you use ProSeries Express, if 
you prefer.)

For this topic... You should know this...

Firm and Preparers Basic information about your firm and the preparers who will be using the 
ProSeries Express software

Electronic Filing Information about the person who will be the electronic filing contact for 
your firm, if you’re going to offer electronic filing to your clients

Bank Products Your bank products registration information, including information about 
the bank account where your fees will be deposited

Billing How you want to set up ProSeries Express billing options such as standard 
fees, hourly charges, and per-form charges
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Getting your computer system ready
You can install ProSeries Express software for stand-alone use or for network use. First, 
decide how you will install and use ProSeries Express software, then get your computer(s) 
ready.

Important: Before you can install ProSeries Express software for network use, you must 
purchase the ProSeries Express/Network Version product.

Decide how you are going to use ProSeries Express software
How you install and then use ProSeries Express software depends on several factors, 
including the number of computers on which you want to use ProSeries Express.

One computer. If you’re going to use ProSeries Express software on one computer, install 
the program for stand-alone use on that computer’s hard drive. See “Installing ProSeries 
Express 2004 software” on page 8.

Multiple computers. If you’re going to use ProSeries Express software on more than one 
computer, you can install the program for stand-alone or network use.

● Stand-alone use. If each preparer maintains an independent set of clients, install the 
ProSeries Express program for stand-alone use on the hard drive of each computer. 
See “Installing ProSeries Express 2004 software” on page 8 for instructions.

● Network use. If preparers regularly share tasks and review returns for other preparers, 
install the ProSeries Express program for network use.
1. Install the ProSeries Express network components to a shared drive from the 

computer you choose to be the ProSeries Express Admin workstation. You’ll also 
install and set up the ProSeries Express program on the ProSeries Express Admin 
workstation at that time.
Any computer (including the network administrator’s workstation) can be the 
ProSeries Express Admin workstation. However, we strongly recommend that the 
ProSeries Express Admin workstation have an Internet connection to help ensure 
that you always have the latest version of the ProSeries Express tax products that 
you use.

2. Install and set up the ProSeries Express program on each additional computer that 
will be a workstation running the ProSeries Express program (and that will access 
ProSeries Express network components and client files from the shared drive where 
ProSeries Express is installed).
For network installation instructions, see “Installing ProSeries Express for network 
use” on page 49 of this guide.

Important: If a preparer is going to prepare returns on a laptop or notebook computer 
that will be mobile (in a manner permitted by the ProSeries Express Software License 
Agreement), install ProSeries Express for stand-alone use on the hard drive of that laptop 
or notebook computer. Make sure to use the Copy/Backup and Restore commands on the 
Client File Maintenance menu (which is accessed from the File menu) when “moving” 
client files from the network to the laptop or notebook, or from the laptop or notebook to 
the network.
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Prepare your computer system
We suggest you review the following before installing ProSeries Express software.

Internet connectivity
Having an Internet connection allows you to take advantage of ProSeries Express features 
such as online delivery of tax products and tax product updates, product licensing, 
electronic filing, bank products, and the www.proseries.com and www.my.proseries.com 
Web sites.

We recommend that the following have a valid Internet connection before you install 
ProSeries Express software:

● Each computer on which you will install ProSeries Express software for stand-alone 
use

● The ProSeries Express Admin workstation from which you install ProSeries Express 
software for network use, because all product downloads and product updates must be 
done at the ProSeries Express Admin computer

Computer performance
We strongly recommend that you do the following for each computer that will run 
ProSeries Express software:

● Run the Scan Disk and Disk Defragmenter system tools to correct any errors on the 
hard drive and speed up access to the contents of the hard drive. (For more 
information, refer to Windows Help.)

● Use virus-protection software to check for viruses on the hard drive.

Know the location of your ProSeries 2003 client files
ProSeries Express software for the 2004 tax year can transfer relevant data from ProSeries 
2003 client files (or data converted to 2003 ProSeries data) into new ProSeries Express 
2004 client files. If you used ProSeries software for the 2003 tax year, make sure you know 
the location of last year’s ProSeries client files—especially if your ProSeries 2003 client 
files are stored on 3.5-inch disks or other external storage media.

Tip: The default installation location for the ProSeries 2003 client file directory was 
C:\ProWin03\03Data.

Know the location of the other important data files
If you use QuickBooks® software or any other software from which you expect to import 
client data, make sure you know where the relevant data files are located.
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Installing ProSeries Express 2004 software
This section explains how to install ProSeries Express software on each computer that will 
use ProSeries Express independently. If you purchased ProSeries Express/Network Version, 
refer to page 49 for instructions.

You install ProSeries Express software from the first ProSeries Express CD that you receive. 
Each ProSeries Express CD contains the latest version of each ProSeries Express tax 
product that’s currently available. (For details about each ProSeries Express CD, see 
“Software service and delivery information” on page 25.)

When you run the ProSeries Express installation program, select each ProSeries Express 
tax product that you expect to use for the 2004 tax year. The installation program will 
install each tax product that you selected, provided the tax product is on the ProSeries 
Express CD. The ProSeries Express User’s Guide will also be installed.

Important: We strongly recommend that you install ProSeries Express when you receive 
the ProSeries Express CD so you can receive other products via the Internet as soon as 
possible. For more information, see “Keeping your ProSeries Express tax products 
up-to-date” on page 25.

Before you install ProSeries Express software for the 2004 tax year, note the following 
important information:

● Release Notes. Read the printed Release Notes and any other material that 
accompanied the ProSeries Express CD.
THE RELEASE NOTES MAY CONTAIN, AMONG OTHER THINGS, ADDITIONAL 
LICENSING TERMS THAT GOVERN THE USE OF THE PROSERIES EXPRESS 
SOFTWARE AND RELATED SERVICES.

● Packing slip. The packing slip that accompanied the ProSeries Express CD contains the 
following information that you will need:
• Your Customer Number and ZIP code
• The install code for ProSeries Express/Network Version, if you purchased

ProSeries Express/Network Version
• The install code for ProSeries/Fixed Asset Manager, if you purchased that program

Installing ProSeries Express software for stand-alone use
To install ProSeries Express software on a computer for stand-alone use:

1 Close all open applications and turn off any virus-protection utilities on the computer.

2 Insert the ProSeries Express CD into the appropriate drive.

Don’t remove the CD from the drive until you finish installing products.

3 In the ProSeries Express Installation dialog box, click Tax Preparation.

If the ProSeries Express Installation dialog box doesn’t appear automatically:
a. Go to the Windows taskbar, click Start, then choose Run.
b. In the Run dialog box, type X:\CDSETUP (where X represents the letter of 

the drive containing the ProSeries CD), then click OK.
c. When the ProSeries Express Installation dialog box appears, click Tax 

Preparation, then continue to Step 4.

4 In the Welcome dialog box, click Next when you’re ready to continue.
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5 A System Warning dialog box appears if your computer doesn’t meet the minimum 
system requirements for the ProSeries Express 2004 software. (For more information, 
see “Computer system requirements” on page 2.)
If the System Warning dialog box appears, read the information, then do one of the 
following:
• Click Cancel to exit the installation program, then correct the situation(s) identified 

in the System Warning dialog box. After your computer meets the minimum 
system requirements for the ProSeries Express 2004 software, start the installation 
procedure with Step 1 on page 8.

• Check the box indicating that you understand you may not receive technical 
support for issues that you may encounter while using the ProSeries Express 
program, then click Next to continue to Step 6.

Important: We strongly recommend that you click Cancel and correct the 
situation(s) identified in the System Warning dialog box. For information about how 
system requirements can affect the operation of ProSeries Express, go to 
www.proseries.com.

6 In the Software License Agreement dialog box, read the ProSeries Express License 
Agreement to understand the scope of your rights to use ProSeries Express software.
• Select I accept the terms of the license agreement if you agree to accept all the 

terms of the ProSeries Express License Agreement, then click Next and continue to 
Step 7.

• Select I do not accept the terms of the license agreement if you don’t agree to 
accept all the terms of the ProSeries Express License Agreement, then click Cancel 
and exit the installation program.

Important: If for any reason you find the terms of the ProSeries Express License 
Agreement unacceptable, do not install the software. Contact ProSeries Express 
Customer Service for a refund instead.

7 In the Select an Installation Type dialog box, select Stand Alone, then click Next.

8 In the Select Destination Directory dialog box, do one of the following:

• Click Next if you want to install ProSeries Express software in a \EXPWIN04 
directory on the drive that’s shown in the dialog box. (That drive will be C: or the 
drive on which last year’s ProSeries software was installed.) Proceed to Step 10.

• Click Browse if you want to install ProSeries Express software to a different drive 
or directory. Continue with Step 9.

Stand Alone is the default 
selection.

If you select Network, see 
Installing ProSeries Express 
for network use on page 49.
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9 In the Select Folder dialog box, take the following steps:

a. Select the drive where you want to install ProSeries Express software.
b. After selecting the drive, type the folder name \ExpWin04 in the Folder 

name field so that it appears after the drive you selected, then click OK.
EXPWIN04 directory. For best results, use EXPWIN04 as the name of your 
2004 ProSeries Express directory. Don’t install ProSeries Express software 
to the root of a drive.

c. When prompted to create the EXPWIN04 directory in the location that 
you’ve specified, click Yes.

d. When you return to the Select Destination Directory dialog box, click Next. 
Continue with Step 10.

10 In the Tax Year 2004 Product Selections dialog box, select the products that you 
expect to use for the 2004 tax year, then click Next.
Tip: If you used ProSeries software for the 2003 tax year, the products that were 
installed last year may already be selected.

Click here if you want to install 
your ProSeries Express products 
on a drive other than the drive 
that’s shown.

See Step 9 for additional 
instructions.

This section explains 
how to use this 
dialog box.

These check boxes 
are for federal 
products.

At least one federal 
product must be 
selected.

Tip: If you select a 
state product, be 
sure to select the 
corresponding 
federal product.

These check boxes are for state products.
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Tip: Every ProSeries Express tax product for 2004 is shown in this dialog box, 
including products that may not be available yet. Select all ProSeries Express tax 
products that you intend to use this tax season. You can install additional products 
later, as described in “Keeping your ProSeries Express tax products up-to-date” on 
page 25.

11 If any of the products you selected aren’t on the CD, you’ll see the Installation Note 
dialog box. Review the list of products that will be installed later (when they become 
available), then click OK. (For more information, see “Keeping your ProSeries Express 
tax products up-to-date” on page 25.)

12 In the E-mail Alert Registration dialog box, click Accept or Decline, depending on 
whether you accept the terms of the E-mail Alerts system, then click Next.
Tip: E-mail alerts inform you when the products you selected for installation become 
available or are updated. E-mail alerts also inform you about support issues, and 
present information relevant to your ProSeries Express products.

13 Review the E-mail Alert Selection on Multiple Computers dialog box, then click OK.

14 In the Disk Space Confirmation dialog box, review the Required Space and Available 
Space information, then click Next.
Installation Failed dialog box. If you see this dialog box, a product was not installed 
properly. Click Help to find a possible solution, then click Exit to exit the installation 
program.

15 Additional components. Wait while additional components, such as any necessary 
fonts, Internet Client software, the ProSeries Express User’s Guide, WexTech® 
AnswerWorks® software, and ProSeries Express Product Licensing components are 
installed. Dialog boxes and progress bars keep you informed.

16 Internet Explorer. If Microsoft Internet Explorer 5.5, service pack 2 or later isn’t 
installed on your computer, the installation program installs Internet Explorer 6.0 
before continuing. ProSeries Express software requires portions of Internet Explorer 
5.5, service pack 2 or later to run properly.

Important: If the installation program installs Microsoft Internet Explorer, you are 
prompted to restart your computer. After the computer restarts, the installation 
program will finish the ProSeries Express installation procedure.

17 Restart Windows message. Restart your computer if you are prompted to do so.

If the installation program doesn’t resume after you restart the computer, 
start the ProSeries Express program by double-clicking the ProSeries 
Express Edition 2004 shortcut icon on your Windows desktop. The 
Connected Customer Wizard will begin automatically. Go to “Setting up 
the ProSeries Express program” on page 12.

18 Setup Complete. In the Setup Complete dialog 
box, click Finish, then continue with Step 19.
We recommend that you leave the check mark 
in the Launch ProSeries Express option.

19 If the Launch ProSeries Express option was 
selected: The Connected Customer Wizard 
begins automatically. Proceed to “Setting up 
the ProSeries Express program” on page 12.
If the Launch ProSeries Express option wasn’t 
selected: You return to the ProSeries Express 
Installation dialog box that’s shown in Step 3 on page 8. Click Exit to return to the 
Windows desktop.
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20 After you return to the Windows desktop, start the ProSeries Express program by 
double-clicking the ProSeries Express Edition 2004 shortcut icon. The Connected 
Customer Wizard will begin automatically.

21 Continue with “Setting up the ProSeries Express program” below.

Setting up the ProSeries Express program
The first time that you start the ProSeries Express program, the Connected Customer 
Wizard helps you set up the program if there’s a valid Internet connection.

Network. The ProSeries Express program should start from the ProSeries Express Admin 
workstation the first time. Don’t set up other workstations to run the program until you’ve 
set up ProSeries Express from the ProSeries Express Admin workstation.

If the computer has a valid Internet connection
If the computer has a valid Internet connection, the Connected Customer Wizard performs 
the following important tasks to save you time:

● Internet Connection. Connects via the Internet to an Intuit ProSeries Express server 
that contains customer information.

● Firm information. Retrieves the name and address of your firm from the Intuit 
ProSeries Express server.

● E-mail address. Retrieves your firm’s e-mail address from the Intuit ProSeries Express 
server.

● Product licensing. Licenses your ProSeries Express tax software to your firm, based on 
your Customer Number, ZIP code, and information in the customer database on the 
Intuit ProSeries Express server.
• Products you’ve purchased as Unlimited are licensed as Unlimited.
• All other products are licensed as Pay-Per-Return.

Important: ProSeries Express uses a product licensing system that doesn’t require 
product access codes. Product licensing information is not printed on the packing slip. 
For more information, see “Product licensing” on page 23.

● Product updates. Checks for updates to the products that were installed from the 
ProSeries Express CD, then downloads and applies the relevant updates, if any.

● New products. Checks for products that you selected for installation that weren’t 
installed from the ProSeries Express CD, then downloads and installs those products, if 
any.

Tip: If you need to edit information that the Connected Customer Wizard retrieves from 
the Intuit ProSeries Express server, you can do that in the ProSeries Express program later.

Go to “Using the Connected Customer Wizard” on page 13.
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If the computer doesn’t have a valid Internet connection
If the computer doesn’t have a valid Internet connection, you see a dialog box that 
explains the benefits of being connected and asks whether you want to start the Internet 
Connection Setup Wizard. If you don’t establish a valid Internet connection, the Options 
Setup Wizard begins. Proceed to “Setting up ProSeries Express options” on page 16. You’ll 
have an opportunity to license your products and to enter your firm’s name and address 
later.

Using the Connected Customer Wizard
When the Connected Customer Wizard starts, go to:

• Step 1 if the computer doesn’t have a valid Internet connection
• Step 2 if the computer has a dial-up Internet connection
• Step 3 if the computer has a valid, non-dial-up Internet connection

1 If the computer doesn’t have a valid Internet connection, a dialog box explains the 
benefits of being connected.
• If you think you might be able to establish a valid Internet connection, click Yes to 

run the Internet Connection Setup Wizard.
After you establish a valid Internet connection and return to the Connected 
Customer Wizard, continue with Step 2.

• If you know you won’t be able to establish a valid Internet connection now, click 
No to exit the Connected Customer Wizard.
The ProSeries Express program will start automatically. Proceed to “Setting 
up ProSeries Express options” on page 16.

Tip: To establish a valid Internet connection at a later time, go to the 
ProSeries Express Help menu and choose Internet Connection Setup.

2 If the computer has a dial-up Internet connection, you are prompted to connect to 
the Internet if the computer isn’t currently connected. After you connect to the 
Internet, continue with Step 3.

3 In the Connected Customer dialog box, click Choose Products to Install if you want to 
view the products that you selected to install, or if you want to select additional 
products for installation.
Click Next in the Connected Customer dialog box when you’re ready to continue to 
Step 4.
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4 The Customer Information dialog box appears so you can enter or verify your 
Customer Number and ZIP code. That information is printed in the Sold To: area in the 
upper-left corner of your ProSeries Express packing slip.

5 Click Next.
The Progress dialog box keeps you informed about what the Connected Customer 
Wizard is doing.
• The Connected Customer Wizard adds a check mark when it successfully completes 

a task.
• If the Connected Customer Wizard is unable to complete a task, you’ll see an “X” 

instead.

Click here to see the Tax 
Year 2004 Product 
Selections dialog box.

Click here when you’re ready 
to continue.

These numbers should match 
the Customer Number and ZIP 
code that are printed in the 
Sold To area of your packing 
slip.

A different Customer Number 
and ZIP code might appear in 
the Ship To area of your 
packing slip.
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6 Click Next after the Connected Customer Wizard finishes the setup tasks.

7 In the Verify Firm Information dialog box, review the information that appears. This is 
the information that we have on file for your firm (based on your Customer Number 
and ZIP code).

Important: Review this information carefully. The ProSeries Express program prints 
this information on all returns prepared by your firm.

8 Click Next.
• If you selected Yes, you see the Verify EMail Address dialog box. Skip to Step 11.
• If you selected No, you see the Enter Firm Information dialog box. Continue with 

Step 9.

9 In the Enter Firm Information dialog box, enter or edit your firm’s name and address, 
then click Next.

10 If you make significant changes to your firm’s name or address, you see the Warning 
dialog box. Call Customer Service to update your firm information in our records, 
then click OK to continue.

11 In the Verify EMail Address dialog box, enter or verify your e-mail address, then click 
Next.

Click Yes if your firm 
information is correct.

Click No if you want to enter or 
edit your firm information.
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12 The Sending Changes to Server dialog box keeps you informed about what the 
Connected Customer Wizard is doing. When it’s done, click Continue.
ProSeries Express checks for product releases and product updates.

13 If there are new products or product updates to download, wait while the Connected 
Customer Wizard downloads and installs those new products and product updates.

14 When the Connected Customer Wizard finishes, the Options Setup Wizard begins so 
you can set up various ProSeries Express options. Proceed to “Setting up ProSeries 
Express options” next.

Setting up ProSeries Express options
You can set up ProSeries Express options by simply going to the Tools menu and choosing 
either Options or Options Setup Wizard as described in this section.

Using the Options dialog box
You can use the Options dialog box to select or change all program options, including 
those that you cannot select or set up using the Options Setup Wizard.

To open the Options dialog box:

1 Go to the menu bar and choose Tools.

2 From the Tools menu, choose Options.
The Options dialog box appears with General selected (in most situations).

3 Click the other selections on the left side of the Options dialog box to see the different 
categories of options.
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4 Press ENTER or TAB, or use your mouse to move to new fields.

5 To get help, click the Help button.

6 After you finish making selections, click OK to save them.

Using the Options Setup Wizard
Using the Options Setup Wizard is the easiest way to set up ProSeries Express options.

To set ProSeries Express options:

1 From the Tools menu, choose Options Setup Wizard.

2 When the Options Setup Wizard starts, the first dialog box you see welcomes you to 
the Options Setup Wizard. Click Next to see the Options Setup Wizard dialog boxes 
for the ProSeries Express options that you need to set before you complete returns.

3 When you finish with a dialog box, click Next.
Most Options Setup Wizard dialog boxes are self-explanatory. However, the next 
sections discuss the following topics in some detail.
• “Entering firm and preparer information” (see page 18)
• “Entering electronic filing contact information” (see page 19)
• “Entering bank products registration information” (see page 20)
• “Registering for bank products through Santa Barbara Bank & Trust and Refund 

Infoline” (see page 20)
• “Entering global billing information” (see page 21)

4 Click Finish to save the options that you selected.

When you 
click a 
selection on 
the left side 
of the 
Options 
dialog box, 
that 
category of 
options 
appears in 
the right 
side of the 
dialog box.

Click the Help button if you want more information about the 
currently-selected section of the Options dialog box.
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Entering firm and preparer information
You enter information about your firm in the Firm/Preparer Information dialog box. If you 
completed the Connected Customer Wizard described on page 13, you’ll see your firm’s 
name and address in the gray area of the Firm Information section.

Tip: If you don’t see your firm’s name and address, you’ll retrieve that information from an 
Intuit Internet server later as explained in “Product licensing” on page 23.

Enter other information about your firm in the fields below the gray area. If the firm will 
be filing returns electronically, be sure to enter the firm’s Electronic Filing Identification 
Number (EFIN).

Enter information about the firm’s preparers in the next section of the dialog box. There’s 
room to enter information for many preparers. If preparers will be filing returns 
electronically, enter Electronic Return Originator (ERO) information in this section also. If 
the ProSeries Express program transferred preparer information from last year’s ProSeries 
program, just edit the information as necessary.

Tip: For information about any field in the Firm/Preparer Information dialog box, right 
mouse click the field, then select About <Field> on the pop-up menu.

During the product licensing 
procedure, your firm’s name and 
address are retrieved from an 
Intuit Internet server, then 
entered here.

Enter other information about 
your firm here.

Enter preparer and ERO 
information in this section.

To move to new fields, press 
ENTER or TAB, or use your 
mouse.
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This table explains some of the fields in the Firm/Preparer Information dialog box:

Entering electronic filing contact information
In the Electronic Filing Contact Information dialog box, enter or edit the name, address, 
phone number, and fax number (if any) of the person who is your firm’s electronic filing 
contact.

The contact information you enter here will be used if an Intuit Electronic Filing Technical 
Support representative needs to reach your firm.

Field Explanation

Firm Name and 
Address

This must be the primary firm name and location used by you in the normal 
course of business (in other words, the firm name and address under which 
you market yourself and your professional services). This information prints in 
the Paid Preparer area on each tax return for which you are the paid preparer.

If you prepare a return for which you are not the paid preparer, and you want 
to substitute an alternative “self-prepared return” or “non-paid preparer” 
designation in the paid preparer section of applicable forms, instead of your 
company’s firm name and address, right mouse click on the Preparer Code 
field, then select About Preparer code on the pop-up menu to see specific 
directions on what to do in those situations.

You can’t enter or edit your firm’s name or address in the Options Setup 
Wizard. To edit information in the shaded area after you finish the Options 
Setup Wizard, go to the Tools menu, select Options, select Firm/Preparer Info, 
click the Edit button, then follow the on-screen instructions. To enter your 
firm’s name and address after you finish the Options Setup Wizard, go to the 
Tools menu, select License Products, select Online or Manual, then follow the 
on-screen instructions.

Preparer Code Enter a code of up to three characters to identify the preparer.
For example, enter the preparer's initials or a numeric code.
Each Preparer Code must be unique.

As you prepare returns, enter this same code on the client's Federal 
Information Worksheet (if an individual return) or in the preparer's block on 
the signature form (if a business return) to associate that return with a 
particular preparer.

Print name in 
signature area?

Check this box to print the preparer's name on the Preparer's Signature line of 
the tax return. The preparer can then write his or her signature on top of or 
next to his or her printed name.

Self-employed? Select this box if you want ProSeries Express to check the Self-Employed box 
in the Paid Preparer area of the tax returns that the preparer prepares.

Checking the Self-employed box does not replace the firm’s name with the 
preparer's name, even if the preparer is self-employed. The firm name always 
prints on the returns for which you are the paid preparer.



20 ProSeries Express Edition Quick Reference Guide 2004

Entering bank products registration information
Enter the required information in the Bank Products Registration Information dialog box.

Registering for bank products through Santa Barbara Bank & Trust 
and Refund Infoline
Use the Register for Bank Products through SBBT and Refund Infoline dialog box if you 
want to use Santa Barbara Bank & Trust as your bank products provider. Select the 
Register for ProSeries Express Bank Products check box to transmit your Bank Products 
registration information to Santa Barbara Bank and Trust and receive a registration 
complete status message from them.

Select the Register for ProSeries Express Refund Infoline to register for Refund Infoline. 
For more information about Refund Infoline, see “More about Refund Infoline” on page 46.

Tip: The Intuit Electronic Filing Center opens for registration on December 1, 2004.

You entered your 
firm’s EFIN and EIN 
in the Firm/Preparer 
Info dialog box.

You must provide an 
EIN or an SSN, but 
you’re not required 
to provide both 
numbers.

The Fax field can be 
blank.

Select this check 
box to register for 
bank products 
through Santa 
Barbara Bank & 
Trust

Select this check 
box to register for 
ProSeries Express 
Refund Infoline.
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Entering global billing information
Use the Global Billing Options dialog box to set the billing options that you want to use for 
all clients. Many billing options are available. If the ProSeries Express program transferred 
global billing information from last year’s ProSeries program, just edit the information as 
necessary.

Important: For detailed information about any field in the Global Billing Options dialog 
box, right mouse click the field and select About <Field> on the pop-up menu.

Enabling and scheduling Task Scheduler tasks
ProSeries Express Task Scheduler automates several tasks for you. Typically, you set up 
Task Scheduler to perform tasks late at night, when you aren’t using your computer.

The ProSeries Express Task Scheduler dialog box identifies the tasks that Task Scheduler 
can perform for you automatically. Initially, all tasks are disabled. Click the check box for 
each task that you want to enable. When you enable at least one task, this dialog box 
indicates the days and time that Task Scheduler is scheduled to perform the enabled tasks.

This dialog box has seven sections:

1 Tax Preparation Fees

2 Hourly Charges

3 Per Form Charges

4 Miscellaneous Fees and 
Adjustments

5 Discount

6 Sales Tax

7 Standard Paragraph

Click the Task 
Scheduler option.

To enable a task, click 
the check box. 

This line identifies 
the current schedule.

To change the current 
schedule, click here. 
(At least one task 
must be enabled.)
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Important: We recommend that you enable the Download New/Update Existing Products 
task to help keep your ProSeries Express tax products current. If you will be filing returns 
electronically, we also recommend that you enable the Receive E-file related 
Acknowledgments task. If you click the Modify Schedule button, you’ll see the Modify 
Schedule dialog box.

Important: If you schedule tasks to run during the night, the computer must be running 
and Task Scheduler must be able to connect to the Internet “unattended.” If your Internet 
connection requires a password, that password must be stored and available.

For more information about Task Scheduler, use the Search Help feature on the Help pane 
to find the information that you want.

Tip: To see detailed information about ProSeries Express options after you finish setting up 
the program, use the Search Help feature on the Help pane. To run the Options Setup 
Wizard whenever you want from within ProSeries, go to the Tools menu and choose 
Options Setup Wizard.

Transferring data from ProSeries 2003 client files
The transfer procedure is a simple way to start your clients’ ProSeries Express 2004 client 
files using the relevant data in their ProSeries 2003 client files.

When you complete the Options Setup Wizard, you are asked if you want to transfer last 
year’s client files.

If you used ProSeries software last year, click Yes to go to the Transfer window, then do the 
five steps listed on the left side of the Transfer window.

Important: When transferring client data on a network, you must select the directory 
where your ProSeries Express 2004 client files are being saved. This directory is set from 
the ProSeries Express Admin workstation during the Options Setup Wizard (or in the 
Directories section of the Options dialog box).

1
Select the type of 
transfer you want to 
perform from the list
of alternatives.

2
Select the location of 
your existing client files.

3
Select a location for the 
new client files.

4
Select the client files that 
you want to transfer data 
from, or click the Select 
All button.

5
After you’ve selected 
one or more clients, click 
Transfer.
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When you click Transfer, the ProSeries Express program creates a new 2004 client file for 
each client whose data is being transferred, then transfers the applicable data into the new 
ProSeries Express 2004 client file.

The Batch Transfer Status dialog box keeps you informed during the Transfer process, and 
the Transfer Log dialog box appears when the ProSeries Express program finishes 
transferring client data. Review the information, then click Close to go to HomeBase. 
HomeBase is discussed in “Overview: Preparing your clients’ returns” on page 27.

Electronic filing. If a 2003 return was marked for electronic filing, that selection is 
transferred to the 2004 return. Practitioner PINs are not transferred. If a client’s 2004 
federal return will be electronically filed using a Practitioner PIN instead of Form 8453, 
open the client’s 2004 federal return, then go to the IRS e-file Authentication Statement. 
You’ll need to retain a completed copy of Form 8879, IRS e-file Signature Authorization, 
that’s been signed by the client.

Tip: For more information about transferring data from ProSeries 2003 client files, use the 
Search Help feature on the Help pane to find the information that you want.

Product licensing
Product licensing is a system that licenses your ProSeries Express tax software to your 
firm. You must have a product license before you can print returns or file returns 
electronically. Products that aren’t licensed for unlimited use can be used on a 
Pay-Per-Return basis. Product licensing no longer requires access codes.

Product licensing uses your Customer Number and ZIP code with information in Intuit’s 
records to deliver the following to your ProSeries Express tax software:

● An unlimited-use license for each ProSeries tax product and ProSeries electronic 
filing product that you’ve purchased for Unlimited use—even if those products haven’t 
been installed yet (except 706 and 709 products)

● Your firm’s name and address

Tip: You can make non-significant changes to your firm’s name and address (such as 
changing “Dr.” to “Drive”) after ProSeries Express product licensing has occurred.

ProSeries Express product licensing can be performed using the Online method or the 
Manual method. For most ProSeries Express users, product licensing occurs online 
automatically.

Automatic, Online product licensing
The Connected Customer Wizard performs product licensing automatically when:

● You install ProSeries Express tax software for stand-alone use on a computer that has 
an Internet connection

● You install ProSeries Express tax software for network use from a computer (referred 
to as the ProSeries Express Admin workstation) that has an Internet connection

Important: When ProSeries Express software is installed for network use, product 
licensing must be initiated from the ProSeries Express Admin workstation. Product 
licensing information is shared by all computers that have been set up as ProSeries Express 
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workstations. See “Installing ProSeries Express for network use” on page 49 for 
information about network install (access) codes. Be sure to read “Updating your firm’s 
product licensing information” on page 25.

Product licensing using the Manual method
If automatic, Online product licensing hasn’t been performed (as explained above), you’ll 
see the message “Product Licensing Required” in the HomeBase Message Center. When you 
click that message, you see a License Products dialog box that includes two options: Online 
(Recommended) and Manual. Select Manual, then click OK. You’ll see the License Products 
dialog box shown on the next page.

Tip: The three ways that you can contact Intuit for manual product licensing are:
•  Automated Touch Tone phone service (call 1-800-723-0692)
•  Online service (go to www.proseries.com and select Product Licensing)
•  Talk to a Customer Service representative (call 1-800-557-5798)

Be sure to read “Updating your firm’s product licensing information” on page 25.

Product licensing with multiple, non-Internet computers
If you install ProSeries Express for stand-alone use on computers that don’t have an 
Internet connection and you don’t want to perform product licensing for each computer 
using the Manual method, here’s a convenient way to copy your firm’s product licensing 
information from one computer to the other computers.

1 From the computer with your firm’s product licensing information, go to the File 
menu, choose Copy Product License, then use the dialog box to save the product 
license file to a network location or removable media (such as a 3.5-inch disk).

2 From each computer that requires product licensing, go to the File menu, choose 
Retrieve Product License, then use the dialog box to retrieve the product license file 
that you copied to the network location or removable media.

Tip: Repeat this procedure if you update the firm’s product licensing information.

1
Verify your Customer Number and ZIP 
code.

2
Enter your firm’s name and address.
(This information must match the 
information contained in Intuit’s records.)

3
Click the Get Key Code button so the 
program will generate a unique Key 
Code.

4
Contact Intuit using one of three 
methods. After you provide the Key Code 
that was generated, you will receive a 
unique Licensing Code from Intuit.

5
Enter the Licensing Code, then click OK.
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Updating your firm’s product licensing information
Update your firm’s product licensing information when:

● You purchase additional ProSeries Express tax products or additional ProSeries 
Express electronic filing products for Unlimited use, or

● The software or an Intuit ProSeries representative instructs you to update your 
product license information

If either of these situations occur, go to the Tools menu, choose License Products, select 
Online or Manual, then click OK. If you chose Online, simply wait for the product licensing 
procedure to conclude. If you chose Manual, just follow the instructions in the License 
Products dialog box.

Keeping your ProSeries Express tax products 
up-to-date
You can install new products and update previously-installed products via the Internet and 
from ProSeries Express CDs that you receive, as explained in this section. Getting tax 
products and updates via the Internet helps you have the most up-to-date versions of the 
ProSeries Express tax products that you use.

Software service and delivery information
ProSeries Express is delivered on two CDs as show in the following table.

For information on release dates and news specific to the products you purchase, log in to 
your personalized www.my.proseries.com page. For other information about product 
release dates, go to http://www.proseries.com/support/release_dates.aspx.

Step 1 - Get products and updates via the Internet
In between CD shipments, you can use the Internet to get any newly-released products and 
product updates (if ProSeries Express is installed on a computer with Internet access). As 
soon as a ProSeries Express tax product or tax product update becomes available, it is 
posted to the ProSeries Express Tax Products Internet server.

ProSeries Express 
CD name Approximate ship date The CD includes these ProSeries 

Express tax products

Tax Release 1 CD Week of November 29, 2004 Updated 1040 and initial 1120, 1120S, 
1065, 706, 709, individual state 
products, and business state products

Tax Release 2 CD Week of January 3, 2005 Final 1040, 1041, remaining individual 
state products, and most business state 
products
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Task Scheduler provides the easiest way to get ProSeries Express tax products and tax 
product updates via the Internet. To use Task Scheduler, take the following steps from each 
computer on which the ProSeries Express program is installed for stand-alone use and the 
ProSeries Express Admin workstation if the ProSeries Express program is installed for 
network use.

1 Go to the Tools menu, choose Options, then select Task Scheduler on the left side of 
the Options dialog box.

2 Enable the Download New/Update Existing Products task. (There’s a check in the box 
before the task when it’s enabled.)

3 If you want to change the Task Scheduler schedule, click Modify, then select the day(s) 
and times that are convenient for you.

4 Make sure the computer is on when Task Scheduler is scheduled to perform tasks.

Password. Task Scheduler must be able to connect to the Internet “unattended.” If your 
Internet connection requires a password, that password must be stored and available.

Tip: To get ProSeries Express tax products and tax product updates via the Internet, go to 
the Help menu and choose Update Installed Products/Download New Products.

Step 2 - Get products and updates from ProSeries CDs
You can install ProSeries Express tax products and tax product updates from ProSeries 
Express CDs that you receive after you’ve installed the program from the first ProSeries 
Express CD.

1 Insert the ProSeries Express CD into your CD drive.

2 Allow the installation program to install the appropriate ProSeries Express tax 
products and tax product updates from that ProSeries Express CD. You can select 
additional products for installation from the Tax Year 2004 Product Selections dialog 
box.

Tip: The on-screen ProSeries Express User’s Guide will be updated, if applicable.

Network. When a ProSeries Express tax product is installed or updated on the network 
drive from the ProSeries Express Admin workstation, it becomes available to all 
workstations on which you installed and set up the ProSeries Express program.

Important: The ReadMe information for the initial release of a product identifies any 
forms that are not ready to be filed yet. If you print a form that can’t be filed yet, the 
printed form includes a “DO NOT FILE” watermark. The ReadMe information for 
subsequent releases of a product identifies any forms that couldn’t be filed with the 
previous release of the product that can now be filed with the current release.

For more information about keeping your ProSeries Express tax products up-to-date, use 
the Search Help feature on the Help pane.

Up
da

ti
ng

Pr
od

uc
ts



Preparing Returns 27

Overview: Preparing your clients’ returns
When you complete the first-time start-up procedures, you see HomeBase. HomeBase 
summarizes information about your clients and client files.

From HomeBase, you start new client files, open existing client files, and perform a variety 
of other tasks involving your client files, such as electronic filing. The first time you start 
the ProSeries Express program, you see client information in HomeBase only if you 
transferred information from last year’s ProSeries client files. As you work on client 
returns, you’ll see information about those clients in HomeBase.

To see information about the clients who meet specific criteria, click the applicable 
HomeBase View tab below the HomeBase toolbar. The ProSeries Express products that are 
installed determine which HomeBase View tabs are available. For example, after ProSeries 
Express/1040 is installed, the following three HomeBase View tabs become available:

Tip: The ProSeries Express program saves the data for a client’s 2004 federal and state 
returns in one client file.

The following table presents a brief summary of the basic steps to prepare client returns. 
Note that many optional steps aren’t included in this table.

Select this HomeBase View tab... To do this...

1040 Prepare federal individual returns and state 
individual returns (using the ProSeries Express/
State products that are installed)

EF Clients All electronic filing tasks

Bank Product Clients All bank products tasks

Select a 
HomeBase 
View tab to 
see 
information 
about a 
specific set 
of clients.

Double-click 
a client file 
to open it.

Client 
Summary

Use the 
scroll bars to 
see all rows 
and columns 
of client 
information. 

Create New Client File HelpPrint Selected ReturnsClient Snapshot

Search Help 
content

Check the Message Center 
for important messages.
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To do this... Do this...

1. Start the client’s 
federal return from 
HomeBase

If you transferred last year’s data, select the appropriate HomeBase 
View tab, then double-click the client’s name to open the client’s file.

If you are starting a new return, click the New Client button on the 
HomeBase toolbar, then select the appropriate federal product.

The appropriate Information Worksheet appears.

2. Prepare the client’s 
federal return

a. Import - If there’s relevant client data in QuickBooks, another 
program, or W-2 data from your client’s payroll provider, go to the 
Import menu and choose the applicable command.

b. Enter data - Enter data in the applicable data fields. Double-click 
forms in the Forms Bar to see them. Import Form W-2 data when 
applicable.

c. Save the data - Click the Save Client button on the toolbar often as 
you enter data.

d. Review - Click the Check for Return Errors button on the vertical 
navigation bar to correct errors that the ProSeries Express program 
identifies.

3. Prepare the client’s 
state return

a. Go to state - Click the Switch to State/City button on the vertical 
navigation bar, then select the appropriate state.

b. Enter data - Enter data in the applicable fields on the state forms.

c. Save the data - Click the Save Client button on the toolbar often as 
you enter data.

d. Review - Click the Check for Return Errors button on the vertical 
navigation bar to correct errors that the ProSeries program identifies.

e. Go to federal - Click the Switch to Federal button on the vertical 
navigation bar to return to the client’s federal return.

f. Prepare additional state returns - Repeat these steps for any other 
state returns that the client must file.

4. Apply for Bank 
Products

a. Go to federal - Click the Switch to Federal button on the vertical 
navigation bar to return to the client’s federal return.

b. Open the EF Bank Prd Wkst form in the Forms Bar.

c. Enter data - Complete the Refund/Bank Products Worksheet.

d. Review - Click the Check for Return Errors button on the vertical 
navigation bar to correct errors that the ProSeries program identifies.

5. Go to HomeBase Click the Go to HomeBase button on the toolbar.

6. Open the client’s 
return(s)

a. Select the appropriate HomeBase view.

b. Double-click the client’s name in HomeBase to open the client’s file (if 
you want to enter or review data).

7. Print the client’s 
return(s)

a. Select the appropriate HomeBase View tab, then select the client in 
HomeBase.

b. Click the Print Client Return button on the toolbar.
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For more information about HomeBase, starting client returns, entering client tax return 
data, saving client return data, and opening previously-saved client returns, use the Search 
Help feature on the Help pane.

Setting up other ProSeries Express features
Use the information in the following table to set up these ProSeries Express features.

8. File the return(s) 
electronically

a. Make sure each return you want to file electronically is marked for 
electronic filing on the Federal Information Worksheet, and that it 
passes return error checking.

b. Click the EF Clients tab, then select the client’s return(s) in the EF 
Clients view.

c. Click the Transmit EF Return button on the toolbar.

d. After 24 to 48 hours, click the Check EF & BP Acks button on the 
toolbar.

To do this... Do this...

Bank Products. Apply for Bank Products so 
you can offer RALs, RTs, and other bank 
product services to your clients.

Go to the Bank Products section of ProSeries.com 
to learn how to register.

Billing clock. Activate the billing clock so it 
tracks the time you spend on each return.

Go to the Tools menu, choose Billing, then choose 
Billing Clock.

Billing rates. Set billing rates for the forms 
and schedules of a specific type of return.

Go to the Tools menu, choose Billing, then choose 
Rates Per Form.

Client template. Enter data that applies to all 
your clients who file a specific type of 
federal return.

Go to the Tools menu and choose Edit Client 
Template.

Internet connection. Set up an Internet 
connection so you can use ProSeries Express 
connectivity features.

Go to the Help menu and choose Internet 
Connection Setup.

Invoices. View or edit the standard invoice 
for a specific type of return.

Open a return of that type, go to the Tools menu, 
choose Billing, then choose View Invoice or Edit 
Invoice.

Letters. View or edit the standard client letter 
or standard recipient letter for a specific type 
of return.

Open a return of that type, go to the Tools menu, 
choose Letters, then choose View Client Letter or 
Edit Client Letter.

Licensing. License your ProSeries Express tax 
products so you can print and file returns 
electronically.

Go to the Tools menu, choose License Products, 
then select Online or Manual.
(We recommend that you select Online.)

Pay-Per-Return. Add funds to a 
Pay-Per-Return account so you can print and 
file returns electronically (for products 
you’re using on a pay-per-return basis).

Go to the Tools menu, choose Pay Per Return, then 
select Increase Account Balance.

To do this... Do this...
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For information about setting, reviewing, and changing ProSeries Express options, use the 
Search Help feature on the Help pane.

Getting help in the ProSeries Express program
The ProSeries Express Help system includes a Help pane at the bottom of your screen with 
three features to help you get the information that you need quickly and easily. From left 
to right, those features are Field/Form Help, Most Common Support Questions, and Search 
Help content.

Refund Infoline. Allows your clients to 
retrieve the status of their e-filed return or 
tax refund using a toll-free telephone 
number.

Go to the Tools menu, choose Options, then select 
Refund Infoline.

Slip sheets. Select options for slip sheets to 
use with envelopes and presentation folders.

Go to the Tools menu and choose Global Slip Sheet 
Options.

W-2 Instant Data Entry. Enables a service 
that imports your client’s W-2 information 
into an open tax return.

Go to the Tools menu, choose Options, then select 
W-2 Import.

To do this... Do this...

Field/Form Help Most Common 
Support Questions

Search Help contentHelp pane
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Field/Form Help
When you’re working on a client’s return, the left area of the Help pane shows information 
about the currently-selected field or form. Click the blue, underlined word “more” to see all 
the current Field/Form Help information in the Help Center. Field/Form Help includes Tax 
Help, Cross-references, and Government Instructions.

Most Common Support Questions
Most Common Support Questions are top support topics linked to information in ProSeries 
Express Help. Click a topic to see the relevant information in the Help Center.

Search Help content
To get answers to a question or information about a keyword or phrase, type the question, 
word, or phrase in the Search Help field, then press the ENTER key or click the Search 
button next to the Search Help field. The program searches ProSeries Express Help content, 
then lists the search results in the Help Center. Click the blue, underlined title of a search 
result to see the full content of that information source in the Help Center or a browser 
window.

Using the Help Center
All three features in the Help pane—Field/Form Help, Most Common Support Questions, 
and Search Help—open the Help Center. From the Help Center, you can get a variety of 
information from one, easy-to-use location.

Tip: The Help Center opens when you click the Help button on the toolbar.
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The Help Center is divided into the following four sections:

● Tax Return Help provides information about the open tax return
● ProSeries Help provides information about using the ProSeries Express program
● Technical Support provides important product information
● ProSeries.com is a resource for online help tools and information

Tip: For more information about ProSeries Express Help, use the Search Help feature on 
the Help pane.

Search for a specific 
topic in Tax Help and 
Program Help here.

Click the selections on 
the left side of the Help 
Center to see the 
corresponding 
information to the right.

Click here to provide feedback that will 
help us improve ProSeries Express help.

Click here to see the 
previous information.

Click and drag the splitter bar 
to adjust the window sizes.

Click here to close 
the Help Center.

Click here to maximize 
the Help Center.

Click a plus sign [+] to 
expand a selection.
Click a minus sign [-] to 
collapse a selection.

Use the scroll bars to see 
all the information in the 
Help Center.

Click blue, underlined 
hyperlinks to see more 
about those topics.
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Using the ProSeries Express User’s Guide
The ProSeries Express User’s Guide is an excellent source of information for all aspects of 
using ProSeries Express software. The User’s Guide is automatically installed on your 
system so it’s available for the Search Help feature.

To open the ProSeries Express User’s Guide from the Help Center:

1 Go to the left side of the Help Center and click User’s Guide.

2 The ProSeries Express User’s Guide title page and Table of Contents appear in the 
ProSeries Express User’s Guide browser window.

3 Click a topic in the Table of Contents, or click the Index or Search tab.

Using ProSeries.com and My ProSeries.com
ProSeries.com (www.proseries.com) includes up-to-date information about ProSeries 
products and services. My ProSeries.com provides content that’s customized for you, such 
as:

● Status of your orders, and release dates of products you’ve purchased
● Register for Bank Products
● A way to complete product licensing manually
● Technical Support answers to current support issues
● Chat support with a ProSeries technical support agent
● E-mail support with historical logs of your e-mail correspondence
● Links to various helpful Web sites

Important: You must set up an account to use My Proseries.com so we can provide you 
with information specific to your ProSeries products.
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Filing returns electronically
ProSeries Express/Electronic Filing software is automatically installed with ProSeries 
Express/1040 and the 42 ProSeries Express/State tax products that support electronic 
filing.

There are three categories for state returns:

• Independent states - California, Illinois, Maine, Massachusetts, and Minnesota
• Federal/State or State-Only states - 34 states (including New York, which 

previously was an Independent state) that aren’t an Independent state or a Federal/
State Only state

• Federal/State Only states - Hawaii, Oklahoma, and Oregon

Important: If you don’t have an IRS-issued Electronic Filing Identification Number (EFIN) 
yet, see “Preparing for electronic filing” on page 3.

Tip: For information about electronic filing of Michigan Single Business Tax returns and 
Massachusetts corporation, S corporation, partnership, and fiduciary returns and 
extensions, use Search or see chapter 11, “Electronically Filing an Income Tax Return” in 
the User’s Guide.

Establishing an Internet connection
To file electronically, you need to be able to connect to the Internet from the computer on 
which the ProSeries Express program is installed.

If you don’t have an Internet connection, you must first sign up for service with an Internet 
Service Provider (ISP). Once you have an ISP, go to the Help menu, choose Internet 
Connection Setup, then follow the instructions in the dialog boxes.

Setting up the ProSeries Express program for electronic 
filing
If you’ve already entered your electronic filing information, proceed to “Step 1 - Mark the 
return for electronic filing” on page 36.

If you haven’t entered your electronic filing information yet, take the following steps to set 
up the ProSeries Express electronic filing options.

1 Go to the Tools menu and choose Options Setup Wizard.

2 In the Firm/Preparer Information dialog box, be sure to enter the firm’s Electronic 
Filing Identification Number (EFIN).
PINs. Practitioner PINs (Personal Identification Numbers) are used as electronic 
signatures. When you use a Practitioner PIN, you don’t mail Form 8453 to the IRS.
If you’re going to participate in the IRS’ Practitioner PIN program, enter each 
preparer’s PIN. This is a five-digit code chosen by each preparer. You’ll need to retain 
a completed copy of Form 8879, IRS e-file Signature Authorization, that’s been signed 
by the client.
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When you have entered the firm’s EFIN and PINs for each preparer, click Next.

3 In the Electronic Filing Contact Information dialog box, complete every field. (You 
can leave the Fax field blank.)

4 Complete the remainder of the Options Setup Wizard.

If more than one computer will be using the same EFIN
When ProSeries Express software is installed on a computer, the DCN (Declaration Control 
Number) counter is set at “00001.” The ProSeries Express program assigns that number to 
the first federal return that’s marked for electronic filing, then increments the DCN counter 
by “1.” As each subsequent federal return is marked for electronic filing, the program 
assigns the current DCN to that return, then increments the DCN counter by “1.”

Important: If your firm will be filing returns electronically from more than one computer 
using the same EFIN on each one (and these computers are not networked), change the 
starting number in the DCN counter in the ProSeries Express program on all but one 
computer before preparers start to transfer or prepare returns. By advancing the DCN 
counter sufficiently in the ProSeries Express program on each “additional” stand-alone 
computer, each return marked for electronic filing will be assigned a unique DCN. For 
example, advance the DCN counter to “01001” on the second computer, to “02001” on the 
third computer, and so on.

Tip: If a computer will be using a unique EFIN, it’s not necessary to change the starting 
number in the DCN counter for that computer.

Enter the firm’s EFIN here.

Enter the preparer’s PIN here.

ProSeries Express transfers 
your firm’s EFIN from the 
Firm/Preparer Information 
section of the Options Setup 
Wizard to this field.

If you entered Electronic 
Filing Contact Information in 
last year’s ProSeries 
program, the program enters 
that information here.
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To change the starting number in the DCN counter for a computer:

1 Go to the Tools menu and choose Options.

2 Select Electronic Filing in the left side of the Options dialog box.

3 Go to the DCN Counter field and increase the number.

Step 1 - Mark the return for electronic filing
To mark a client’s federal and state returns for electronic filing:

1 Open the client’s federal return, go to the Federal Information Worksheet, scroll down 
to Part IV - Filing Information, then make sure the appropriate preparer code is 
entered in the Preparer Code field.

Tip: If you’re acting as an ERO and filing a return for another preparer, enter that 
preparer’s preparer code in the Preparer Code field.

2 Make sure the Check this box to file the federal return electronically box is checked.

3 State returns. If you’re going to file the client’s state return (or returns) electronically, 
enter the appropriate information in the Choose state(s) to file electronically 
expanding table.

4 Enter all other relevant information in the Filing Information section.

5 Direct Deposit/Direct Debit. If the client wants their refund deposited directly into 
their account or the balance due withdrawn from their account, complete Part V - 
Direct Deposit or Electronic Funds Withdrawal Information.

Check this box to file the federal return electronically.

Enter 
information 
about the 
state 
return(s) for 
electronic 
filing in this 
expanding 
table.

See Help if 
you need 
assistance.

Enter the Preparer Code here.
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Step 2 - Prepare the client’s return(s) for electronic filing
To prepare a client’s return(s) for electronic filing:

1 Complete the client’s federal return.

2 Complete the Electronic Filing Smart Worksheets on the client’s Form W-2, 1099-R, 
W2-G, and 1099-G worksheets (if applicable).

3 RAL or RT. If you’re participating in the ProSeries Express/Bank Products program and 
the client wants a Refund Anticipation Loan or Refund Transfer, complete the 
applicable parts of the Refund/Bank Product Information Worksheet.
For more information, see “Overview of Bank Products” on page 45.

4 Click the Switch to State/City button on the vertical navigation bar.

5 Complete the client’s state return.

6 Click the Switch to Federal button on the vertical navigation bar.

7 Go to the toolbar and click the Save Client button.

Avoiding common reasons for rejection

● Verify the client’s social security number (SSN) and Date of Birth (DOB) with the 
Social Security Administration (SSA).

● If you’re preparing a Married Filing Joint return, verify that the spouse’s last name on 
the return matches the spouse’s last name on his or her Social Security card.

● Make sure the employer’s name and federal identification number on the actual Form 
W-2 match the information you’ve entered in the ProSeries Express program.

Check this box to 
use direct deposit of 
any federal refund.

Check the 
appropriate Yes box 
in this area to use 
electronic funds 
withdrawal of a 
federal balance due 
(if using electronic 
filing).

Be sure to complete 
the rest of Part V.
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● Make sure the payer’s name and federal identification number on the actual Form 
W-2G or Form 1099-R match the information you’ve entered in the ProSeries Express 
program.

● Use error-checking during data entry. To do so, go to the View menu and make sure 
there’s a check mark before Error Alerts.

Step 3 - Run error checking from the client’s return
After you complete a federal or state return, run the ProSeries Express error check to help 
you check the return for errors.

1 To review the open federal or state return, click the Check for 
Returns Errors button on the vertical navigation bar.

2 Analyze the error report, and fix all errors that are identified.

3 Click Recheck to check the return for errors.

4 Not using PINs. If you’re not participating in the IRS Practitioner PIN program, review 
Form 8453 in the client’s federal return. (If you’re participating in the IRS Practitioner 
PIN program, you don’t need to file Form 8453 with the IRS.) Also review the 
electronic filing paperwork form in the client’s state return, if applicable. Review the 
form(s) and return(s) with the client.

Tip: The ERO PIN is used as an electronic signature. An ERO PIN can be any five 
digits (except all zeros). You enter your PIN in the Firm/Preparer Info section of the 
Options dialog box.

5 Using PINs. If you’re participating in the IRS Practitioner PIN program and the client 
wants to use a PIN, go to the IRS e-file Authentication Statement in the client’s federal 
return, make sure the box at the top of the form is checked, then complete the 
remainder of the form.
For more information, click the Help button while the IRS e-file 
Authentication Statement is open on the screen. Review the form and the 
return(s) with the client.

Tip: You’ll need to retain a completed copy of Form 8879, IRS e-file Signature 
Authorization, that’s been signed by the client.
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Step 4 - Select a Bank Product
To prepare a client’s return for a Refund Anticipation Loan, a Refund Transfer, a Refund 
Transfer Direct Deposit, or other bank product:

1 Complete the Refund/Bank Product Worksheet.

2 Click Check for Return Errors to check the return for possible errors and omissions.

3 Go to the toolbar and click the Save Client button.

Step 5 - From the EF Center, select the return(s)
To select client returns for electronic filing:

1 Go to the HomeBase EF Center. If HomeBase is on the screen, click the EF 
Clients tab below the toolbar. If a return is on the screen, go to the toolbar 
and click the Go to EF Clients button.
The HomeBase EF Center presents important information about each client return that 
you’ve prepared and marked for electronic filing, including the status of each return.

2 Select the returns that you want to file electronically. Their status should be Return 
Marked for EF.

Select a 
Refund 
method

Select a 
disbursement 
method
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• To select consecutive client returns, click the first client return, then hold down the 
SHIFT key and click the last client return.

• To select non-consecutive client returns, hold down the CTRL key while you click 
each client return.
State returns. State returns are listed after the corresponding federal return. 
Select a client’s federal and state returns at the same time.

Tip: While California, Illinois, Maine, Massachusetts, and Minnesota 
returns do not need to be electronically filed with the corresponding federal 
return, it’s best to do so. If an Arizona, North Dakota, or South Carolina 
return isn’t filed with the corresponding federal return, it can’t be 
electronically filed until the federal return is accepted.

Step 6 - Convert and transmit the selected return(s)
To electronically file the returns that you selected in step 5:

1 Go to the toolbar and click the Transmit EF Return button.

2 If any informational dialog boxes appear, read the information, then click 
OK.

3 In the Electronic Filing Options dialog box, select Convert and Transmit selected 
returns/extensions.

Transmit EF Return buttonThe status should be Return Marked for EF.

These 
returns 
are 
selected.
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4 Make sure Enable conversion error checking is selected.

Tip: A return that cannot pass error checking will usually get rejected by the IRS. 
Therefore, do not disable conversion error checking unless directed to do so by a 
ProSeries Express Technical Support Representative.

5 Click OK.

When the ProSeries Express program finishes converting and transmitting the returns, the 
Transmit Electronic Filing Returns/Extensions Log appears so you can review the results.

Step 7 - Wait 24 to 48 hours, then check for 
acknowledgments
Tip: ProSeries Express automatically checks for acknowledgments when you transmit 
client returns. It may take more than 48 hours to receive an acknowledgment for some 
federal and state returns.

To check for acknowledgments from the IRS or state taxing authorities:

1 Go to the HomeBase EF Center. If HomeBase is on the screen, click the EF 
Clients tab below the toolbar. If you are currently working on a client’s 
return, save the file, then go to the toolbar and click the Go to EF Clients 
button.

2 Click the client’s status in the Status column of the EF Center to open the client’s 
Electronic Filing Client Status History.

Tip: Entries in the Status column are blue and underlined. A client’s status becomes 
bold when your mouse pointer rests on it.

3 Review the Electronic Filing Client Status History and identify the most recent status 
of the client’s return, then click Close.

Tip: If a client’s return was rejected, the report shows why it was rejected, and how to 
fix the error.

4 If the most recent status of the return is “Return Accepted,” proceed to “Step 8 - 
Complete the electronic filing process” on page 42.
If the most recent status of the return is “Return Rejected,” proceed to “Resolving a 
problem with a rejected return” on page 42.
If the most recent status of the return isn’t “Return Accepted” or “Return Rejected,” 
continue with Step 5.

5 Go to the E-File/Bank Products menu and point to Electronic Filing.

Make sure there’s a 
check in this box. 
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6 From the Electronic Filing menu, choose Check EF 
Acknowledgments to get the latest 
acknowledgments.

7 In the Receive Electronic Filing Acknowledgments 
dialog box, check the listing for electronic filing 
acknowledgments.

8 Review the information, then click Close. If the 
return was rejected, continue with “Resolving a problem with a rejected return” next.

Resolving a problem with a rejected return
To resolve a problem with a rejected return:

1 From the EF Center, go to the E-File/Bank Products menu, point to Electronic Filing, 
choose Reports, then print a Rejected Returns report.

2 Incorrect SSN. If a return was rejected because the taxpayer’s social security number 
wasn’t correct, print the Intuit Electronic Postmark Report before correcting the social 
security number and resubmitting the return. This provides the original date and time 
of filing.

3 Fix the errors in the rejected return.

4 Make sure the corrected return passes error checking.

5 Convert and retransmit the corrected returns as explained in “Step 5 - From the EF 
Center, select the return(s)” on page 39 and “Step 6 - Convert and transmit the selected 
return(s)” on page 40.
Re-filing state returns. If you’ve filed a client’s federal and state returns together and 
the federal return is accepted but the state return is rejected, in most cases you can 
re-file the corrected state return electronically. However, you cannot re-file corrected 
Hawaii returns, Oklahoma returns, or Oregon returns electronically because they can 
only be filed with the client’s federal return. To re-file a corrected Hawaii return, 
Oklahoma return, or Oregon return, you must print the return, then mail it to the 
appropriate state taxing authority.

Step 8 - Complete the electronic filing process
After the IRS or state taxing authority has accepted a return, take these steps to complete 
the filing process:

1 Not using PINs. If you and your client are not using PINs, attach any required paper 
documents to Form 8453, U.S. Individual Income Tax Declaration for an IRS e-file 
Return. Do this for each return that has been accepted, then continue with Step 2.

Tip: The Preparing Form 8453 section of the Electronic Filing Information Worksheet 
identifies the paper documents to attach to the client’s Form 8453.
Using PINs. If you and your client are using PINs, you don’t need to mail Form 8453 to 
the IRS. However, you may need to mail state electronic filing paperwork to the 
appropriate state service center. Skip to Step 3.

Tip: To determine if a client’s return was filed with PINs, go to the EF Center and 
scroll across to the PIN column. If the return was transmitted with a PIN, you’ll see a 
“Y” in the PIN column. If the return was transmitted without a PIN, you’ll see an “N” 
in the PIN column.
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2 After you’ve been informed the federal return was accepted, mail the completed Form 
8453 to the appropriate IRS service center within the time period required by the IRS.

Tip: The Mailing Form 8453 section of the Electronic Filing Information Worksheet 
shows the Form 8453 mailing address.

3 State forms. After you’ve been informed the state return was accepted, mail the 
completed state electronic filing paperwork to the appropriate state service center 
within the time period required by appropriate taxing authority (if the state taxing 
authority requires electronic filing paperwork, mail the completed state electronic 
filing paperwork to the appropriate state service center within the time period 
required after the state return is accepted).

4 Print Form 9325, Acknowledgment and General Information for Taxpayers Who File 
Returns Electronically, and give it to your client.
To print Form 9325:
a. Open the client’s federal return.
b. Go to the File menu, choose Print, then select Print Selected Forms.
c. Click Choose, select Form 9325: General Information for Electronic Filers, 

then click OK.
d. Click Print.
IRS refund cycle. For information about the IRS refund cycle, go to 
www.proseries.com, select E-Filing, select How to E-File, then select IRS Refund Cycle.

5 Balance due. If you filed a balance-due return and your client did not elect to pay 
with a Discover Card or to have their bank account directly debited, print Form 
1040-V, Balance Due Payment Voucher, and give it to your client.
Federal taxes. If your client owes federal taxes, he or she must mail Form 1040-V and 
the payment to the IRS no later than April 15, 2005.
State taxes. If your client owes state taxes, complete the state tax payment voucher at 
the same time.

6 Getting current information. To review common reject reasons, troubleshooting 
information, and frequently-asked questions from www.proseries.com, do either of the 
following:
• While in the ProSeries Express EF Clients View, click the Help button, then click 

Quick Anwers, then click Electronic filing.
• While in your Internet browser, go to www.proseries.com, select E-Filing, then 

select E-Filing FAQs.

Step 9 - Complete the Bank Product acknowledgment 
process
You can manually receive bank product acknowledgments for selected clients any time, 
even if Task Scheduler is already scheduled to check for electronic filing-related 
acknowledgments.

1 Click the Bank Product Clients tab.

2 Go to the E-File/Bank Products menu, choose Bank Products, then click Check Bank 
Products Acknowledgments.
The ProSeries Express program connects to the Intuit Electronic Filing Center.
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Tip: If there is a message for you from Santa Barbara Bank & Trust, the message 
appears.

3 When the connection is complete, the Bank Products Transmission log appears, 
displaying any new authorizations and status messages you received.
• To print the contents of the log, click Print Log.
• To close the Bank Products Transmission log, click Close.
• To view detailed reasons for denial of a RAL, go to the E-File/Bank Products menu, 

choose Bank Products, choose Reports, then choose Bank Product Denied RAL 
Report.

• To view details on accepted RALs, go to the E-File/Bank Products menu, choose 
Bank Products, choose Reports, then choose Bank Products RAL Status Report.

• To view details on RTs, go to the E-File/Bank Products menu, choose Bank 
Products, choose Reports, then choose Bank Products RT Status Report.

When you’re ready to print refund checks, go to the E-File/Bank Products menu, choose 
Bank Products, then choose Print Checks.

Refer to the next section, “Overview of Bank Products” for more information about using 
Bank Products.

For detailed information about electronic filing, including information about filing 
Michigan Single Business Tax returns and Massachusetts corporation, S corporation, 
partnership, and fiduciary returns and corporate extensions electronically, use the Search 
Help feature on the Help pane, then go to chapter 11, “Electronically Filing an Income Tax 
Return.”
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Overview of Bank Products
When you file your clients’ federal individual returns electronically, those clients may be 
eligible to receive a disbursement based on their expected federal refunds in the form of 
bank products such as Refund Anticipation Loans (RALs), Advances on RALs and RTs, 
Refund Transfers (RTs), and Refund Transfer Direct Deposits (RTDDs). Similarly, when you 
file your clients’ state individual returns electronically, those clients may be eligible to 
receive a disbursement based on their expected state refunds in the form of Refund 
Transfer (RT) bank products. In addition, your fees are deducted from the client’s refund 
and deposited into your bank account electronically.

ProSeries Express/Bank Products software is included with ProSeries Express/1040 and 
integrates with ProSeries Express/Electronic Filing software. You can offer bank products 
through Santa Barbara Bank & Trust (SBBT) which is integrated with ProSeries Express or 
you can offer bank products through First Security Bank or Republic Bank.

Tip: For more information about offering bank products through Santa Barbara Bank & 
Trust, First Security Bank or Republic Bank, see chapter 12, “Getting Tax Refunds Using 
Bank Products” in the ProSeries Express User’s Guide, or go to www.proseries.com.

The following table summarizes the basic steps for offering bank products to your clients 
through Santa Barbara Bank & Trust:

To take this step... Do this...

1. Apply to Santa Barbara Bank 
& Trust to participate in their 
bank products program.

Go to the Bank Products section of ProSeries.com to learn 
how to register.

2. Set the ProSeries Express Bank 
Products options.

a. Go to the Tools menu, choose Options, then select Bank 
Products.

b. Select the Bank Products options that you want.

c. Click Registration Information, then enter the requested 
information in the Bank Products Registration Information 
dialog box.

3. Transmit your registration 
information to Santa Barbara 
Bank & Trust (any time after 
12:00 a.m. PST on 12/1/04).

a. Go to the HomeBase Bank Products view.

b. Go to the E-File/Bank Products menu, point to Bank 
Products, then choose Transmit Registration Information.

4. Check for the registration 
acceptance status from Santa 
Barbara Bank & Trust.

a. Go to the HomeBase Bank Products view.

b. Go to the E-File/Bank Products menu, point to Bank 
Products, then choose Receive Authorization/Status 
Information.

5. Prepare the client’s federal 
return for a bank product. If 
applicable, prepare the client’s 
state return(s) for a bank 
product.

a. Prepare the client’s federal and state return(s).

b. Prepare the client’s federal return (and state return(s) if 
applicable) for electronic filing.

c. Complete the Bank Product Information Worksheet in the 
client’s federal return.

d. Review the client’s return(s) and make sure the return(s) 
successfully pass error checking.

e. Print the Refund Application Loan (RAL) and Refund 
Transfer (RT) Application and Agreement form from the 
client’s federal return, and have the taxpayer(s) sign it.
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More about Refund Infoline
Refund Infoline allows you to provide your clients a toll-free telephone number that they 
can use to check the status of their tax return refunds and bank products at anytime. Using 
this feature eliminates the need to take calls from clients who call and ask “Where’s my 
check?” regarding the status of their income tax refund. When your clients call this 
number, they’ll have the option to hear the status of their tax refund in English or Spanish.

When your clients call the Refund Infoline, they’ll hear the most up-to-date status about 
their tax return such as:

● Your refund is awaiting approval by the bank
● Your refund check is ready to be picked up
● Your cash card or direct deposit is funded
● Your tax return is pending approval by the IRS

Once you’ve printed a client’s refund check and you’re ready for the client to pick up his or 
her return, you’ll use the ProSeries Express program to send a “Client Package Ready” 
message to the Refund Infoline system to change the status of the client’s refund. The 
Refund Infoline is automatically updated with client status by Intuit’s electronic filing 
system with one exception: your clients will not hear the “Your Client Package/Check is 
ready” message until you tell the Refund Infoline that you are ready for the client to know 
this status.

6. File the client’s return(s) 
electronically.

a. Go to the EF Center and select the client’s return(s).

b. Go to the E-File/Bank Products menu, point to Electronic 
Filing, then choose Convert/Transmit Returns and 
Extensions.

7. Receive bank product print 
authorizations and status 
messages.

a. Go to the HomeBase Bank Products view.

b. Go to the E-File/Bank Products menu, point to Bank 
Products, then choose Receive Authorization/Status 
Information.

8. Activate the Refund Infoline. a. Go to the Tools menu, click Options then click Refund 
Infoline.

b. Select Enable your clients to receive e-file and bank 
product status from the ProSeries Express Refund Infoline.

9. Print the client’s Refund 
Anticipation Loan or Refund 
Transfer check. (This step isn’t 
applicable for Refund Transfer 
Direct Deposits.)

a. If “Ready to Print” appears in the Status column of the 
HomeBase Bank Products view, select the client.

b. Go to the E-File/Bank Products menu, point to Bank 
Products, then choose Print Checks...

c. Deliver the check to the client.

10. If there’s a problem with a 
check, resolve the problem.

a. Go to the HomeBase Bank Products view and select the 
client whose check is affected.

b. Go to the E-File/Bank Products menu, point to Bank 
Products, then choose Resolve Check Problems...

11. View or print Bank Products 
reports.

a. Go to the HomeBase Bank Products view and select the 
client returns that you want to include in the report.

b. Go to the E-File/Bank Products menu, point to Bank 
Products, then choose Reports.

To take this step... Do this...
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The Refund Infoline is a $199 value. However, you will not be charged for Refund Infoline 
for Tax Year 2004.

Setting up Refund Infoline
If you want to use the Refund Infoline, you can sign up in one of two ways: (1) you can 
opt-in during the Options Setup Wizard, or (2) go to the Tools menu, choose Options, then 
select Refund Infoline. In the Refund Infoline dialog box, select the Enable your clients to 
receive e-file and bank product status from the ProSeries Express Refund Infoline check 
box.

You can have ProSeries Express update the “Client Package Ready” status automatically 
when you print your client’s refund check. To do so, select the Automatically set the 
options to update the Refund Infoline status to “Client Package Ready” when checks are 
printed check box.

Tip: You can also select (or clear) this option when you click the Print Check button on the 
toolbar.

Refund Infoline telephone number
When you meet with your clients to prepare their returns, you’ll give them the toll-free
1-866-373-9777 telephone number that they can call 24 hours-a-day, seven-days-a-
week to get the status of their returns.
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Using Refund Infoline
When you e-file a client’s tax return and then later want to update the 
status of his or her tax refund to “Client Package Ready,” click the Update 
Refund Infoline button on the ProSeries Express toolbar.

You’ll probably want to update the Refund Infoline after you’ve printed refund checks for 
clients if you didn’t already select the check box to update the Refund Infoline 
automatically in the Options dialog box.

In the Update Refund Infoline dialog box, select the check box in the “Client Package 
Ready” column for the clients that you want to update. You can select individual or 
multiple clients to update. When you are ready, click Update. The program then transmits 
the “Client Package Ready” status to the Refund Infoline system.

To view and confirm the client status, click the Bank Product Clients tab to see the 
“InfoLine Updated” column that shows the date that the updated status was sent to the 
Refund Infoline system.

For more information about Refund Infoline or bank products in general, use the Search 
Help feature on the Help pane, or select User’s Guide in the Help Center.

Select this 
check box to 
update the 
Refund 
Infoline to 
“Client 
Package 
Ready” 
status.
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Installing ProSeries Express for network use
The following pages describe system requirements and other information you need to 
know before installing ProSeries Express software for network use.

Important: Before you begin installing your 2004 ProSeries Express software, be sure to 
read pages 1 through 7. We also recommend that you review all the information in this 
guide.

If you have additional questions, including questions about specific types of networks, go 
to www.proseries.com, choose “Help & Support,” then choose “Browse Support Articles.”

Computer system requirements for network operation
“Computer system requirements” on page 2 lists the computer system requirements for 
ProSeries Express 2004. The following table lists additional system requirements for 
network operation. For more information about how system requirements can affect 
ProSeries Express operation, go to www.proseries.com.

Component Recommendation Minimum Requirement

Additional system requirements for network operation

Server Pentium 4, 1.3 GHz CPU or higher as a 
dedicated File/Application server

A higher speed CPU normally results in 
improved performance.

Pentium 3, 650 MHz (or 
equivalent AMD processor) as a 
dedicated File/Application server 
or host on a peer-to-peer network

Total server 
memory

256 MB RAM plus 128 MB RAM per 
workstation on the server*

128 MB RAM plus 128 MB RAM 
per workstation on the server*

Server hard 
disk space

2 GB or more

The amount of hard disk space required 
depends on the number of products you 
install and the number of client returns 
you prepare.

650 MB

More space may be required if you 
install many products or prepare a 
large number of returns.

Server
operating 
system

One of the following:

• Windows 2000 Server

• Windows 2000 Advanced Server

• Windows XP (Professional edition)

• Windows 2003 Server

One of the following:

• Windows XP (Home edition)

• Windows NT (version 4.0, 
service pack 6a or later)

• Windows 98 (second edition)

• Novell Netware (version 5.1 or 
later)

Workstation 
hard disk space

2 GB 650 MB

Workstation 
memory

512 MB RAM or more 128 MB RAM

Workstation 
operating
system
(on each 
workstation)

One of the following:

• Windows XP (Professional or Home 
edition)

• Windows 2000 (service pack 3 or later)

One of the following:

• Windows NT (version 4.0, 
service pack 6a or later)

• Windows 98 (second edition)
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* Memory requirements. Microsoft memory requirements for Windows Server 2000 and 
Windows Server 2003 are a minimum of 128 MB RAM minimum, although 256 MB RAM is 
recommended. These memory requirements are just for the server operating system. For 
each workstation, add a minimum of 64 MB RAM per workstation to these figures. Adding 
128 MB RAM per workstation is recommended to improve performance.

Decide how you are going to install and use ProSeries 
Express
Important: In order to install ProSeries Express software for network use, you must 
purchase the ProSeries Express/Network Version product.

How you install and use ProSeries Express software depends on several factors, including 
the number of computers that will be running ProSeries Express.

One computer. If you are going to use ProSeries Express software on one computer, install 
the program for stand-alone use on that computer’s hard drive. See “Installing ProSeries 
Express software for stand-alone use” on page 8.

Multiple computers. If you are going to use ProSeries Express software on more than one 
computer, you have three options for installing and using the program. See the table below.

Network 
infrastructure

100 MB optimized connection 
environment (Network Interface Cards, 
Cat V cabling, and Hubs)

10 MB optimized connection 
environment (Network Interface 
Cards, Cat V cabling, and Hubs)

To use ProSeries Express 
software this way... Install the program this way...

Each preparer maintains an 
independent set of clients

Go to each computer and install ProSeries Express software (from 
the ProSeries Express CD) for stand-alone use on that computer’s 
hard drive.

Preparers share clients and 
regularly review returns for 
other preparers

1. Go to the computer that you choose to be the ProSeries Express 
Admin workstation, then install ProSeries Express software 
(from the ProSeries Express CD) for network use. You’ll (a) 
install ProSeries Express network components to a shared drive 
and (b) install and set up the ProSeries Express program on that 
computer’s hard drive.

2. Go to each computer that will serve as a workstation that (a) 
runs ProSeries Express and (b) accesses the ProSeries Express 
network components from the shared drive, then install and set 
up the ProSeries Express program (from the shared drive, using 
Windows Explorer) on that computer’s hard drive.

Component Recommendation Minimum Requirement
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ProSeries Express Admin workstation. Any computer (including the network 
administrator’s workstation) can be the ProSeries Express Admin workstation. However, 
because all product downloads and updates from the Internet must be done at the 
ProSeries Express Admin workstation, the computer that you select should have an 
Internet connection. For more information about deciding which computer will be the 
ProSeries Express Admin workstation, see “Choosing the ProSeries Express Admin 
workstation” on page 52.

Advantages of network installations
The following table lists some of the features that you can take advantage of when you 
install ProSeries Express software for network use (compared to stand-alone use):

Preparers work in the office 
sharing and reviewing 
returns.

Some preparers use laptop or 
notebook computers to begin 
and prepare returns at client 
sites.

1. Go to the computer that you choose to be the ProSeries Express 
Admin workstation, then install ProSeries Express software 
(from the ProSeries Express CD) for network use. You’ll (a) 
install ProSeries Express network components to a shared drive 
and (b) install and set up the ProSeries Express program on that 
computer’s hard drive.

2. Go to each computer that will serve as a workstation that (a) 
runs ProSeries Express and (b) accesses the ProSeries Express 
network components from the shared drive, then install and set 
up the ProSeries Express program (from the shared drive, using 
Windows Explorer) on that computer’s hard drive.

3. Go to each laptop or notebook computer, then install and set up 
ProSeries Express software (from the ProSeries Express CD) for 
stand-alone use on that computer’s hard drive.

Note: If you install ProSeries Express software for stand-alone use 
on a laptop or notebook computer, be sure to use the Copy/Backup 
and Restore commands on the Client File Maintenance menu 
(which is accessed from the File menu) when “moving” client files 
from the network to the laptop or notebook, or from the laptop or 
notebook to the network.

This feature... Offers this advantage with network use...

Internet 
connection

Only the workstation from which you install ProSeries Express software (the 
ProSeries Express Admin workstation) needs an Internet connection. 
However, because all product downloads and updates from the Internet must 
be done at the ProSeries Express Admin workstation, that computer should 
have an Internet connection.

Client files The ProSeries Express program prevents more than one user from working 
on an open client file, which helps prevent client data from being 
overwritten.

Pay-Per-Return All workstations share one Pay-Per-Return account.

Control/Access Some features (such as Task Scheduler) can be changed only from the 
ProSeries Express Admin workstation.

To use ProSeries Express 
software this way... Install the program this way...
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Prepare your networked computer system
Before you can install ProSeries Express software, you must prepare your networked 
computer system. The specific steps that are appropriate for your system depend on the 
type of network and the way it’s set up.

It’s helpful to know some network-related terms before you start. The table below explains 
some of the more common terms.

Important: For more information about shared folders, drive mapping, and access rights, 
refer to your network vendor’s documentation.

Choosing the ProSeries Express Admin workstation
Your first step is deciding which computer will be the ProSeries Express Admin 
workstation. Use the following information to help you decide.

● Internet access. Because all product downloads and updates from the Internet must be 
done at the ProSeries Express Admin workstation, the computer that you select should 
have an Internet connection.

● Type of network. Determine whether you’re using a client-server network or a peer-to-
peer network.
• Client-server network. You install ProSeries Express software from the ProSeries 

Express Admin workstation to the server’s hard drive. With this type of system, the 

ProSeries Express 
options and 
features

Each user can set up most ProSeries Express options and features the way 
that he or she wants on his or her workstation.

Some ProSeries Express options and features (such as firm/preparer 
information, global billing options, and standard letters and invoices) are the 
same for all workstations. If a user changes one of these “global” options or 
features, the change affects all workstations.

Term Explanation

Mapped drive Any drive or shared resource that has a drive letter assigned to it.

Shared drive or folder The drive or folder that is set up by the Network Administrator to be 
shared in the network system. The ProSeries Express shared folder is 
the location where ProSeries Express network components, client files, 
and HomeBase database files reside within the shared drive.

Primary file location This is the location where all current-year client files are stored.

Client-Server network A network setup where only one computer (the server) shares resources 
used by one or more workstations (the clients).

Peer-to-Peer network Up to 10 computers that are linked together. One or more systems may 
share resources.

ProSeries Express 
Admin workstation

The computer from which ProSeries Express software is installed to the 
serving computer.

You can designate any computer to be the ProSeries Express Admin 
workstation (including the network administrator’s computer), but once 
you choose a ProSeries Express Admin workstation, it must remain the 
ProSeries Express Admin workstation throughout the tax season.

This feature... Offers this advantage with network use...
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ProSeries Express Admin workstation and the server are two different computers. 
The ProSeries Express Admin workstation can be used as a workstation, but the 
server is not used as a workstation.

• Peer-to-Peer network. You install ProSeries Express software on the ProSeries 
Express Admin workstation’s hard drive. With this type of system, the ProSeries 
Express Admin workstation can be used as a workstation.

● Performance. We recommend that you don’t use the server (in a client-server network) 
as a full-use ProSeries Express workstation. Doing so can degrade network 
performance.

Create a shared folder
We recommend that you create a shared folder on the shared drive where you will be 
installing ProSeries Express 2004 network components. To do that:

1 Create a folder on the drive where you will be installing ProSeries Express 2004 
network components.

2 Name the shared folder. For example, name it “Netshare” or another name that you 
prefer.

3 Make the folder a shared folder.

4 Install ProSeries Express 2004 software from the ProSeries Express Admin 
workstation to the shared folder.

Tip: The shared folder doesn’t have to be mapped to a network letter as long as all 
workstations can access the shared folder.

Note the following information about shared folders:

● Peer-to-Peer network. If you are running a Peer-to-Peer environment, you can install 
ProSeries Express 2004 software to the root of C:\ and share the whole C:\ drive. (Note 
that if you do this, you give everyone on your network access to all files and folders 
on your C: drive.)

● File caching. If you’re using a shared NTFS drive, take the following steps to turn off 
file caching for the shared folder:
• Go to Windows Explorer, right mouse click on the shared folder that you created 

for the ProSeries Express software, then choose Sharing.
• Click Caching in the dialog box, make sure there isn’t a check in the “Allow 

caching of files in this shared folder” box, then click OK.

Mapped drives
Note the following about mapped drives:

● If you’re an existing ProSeries network user and have all computers mapped to the 
same drive letter, you don’t have to change anything. Install ProSeries Express 
software as you always have.

Tip: When you install ProSeries Express software this year, network components are 
installed on the shared folder, and the ProSeries Express program is installed on each 
workstation.

● If all of your workstations are mapped to a network shared folder using different drive 
letters, you don’t have to re-map all of your workstations.

● If you’re an existing ProSeries Express network user and you’ve added new computers 
to your network, we recommend setting up these computers the same as the existing 
workstations on your network.
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● If you are a new user installing ProSeries Express software for the first time, you can 
install ProSeries Express directly to a shared folder without mapping drives. You can 
run the workstation installation and setup from all other computers by accessing this 
shared folder.

Important: If you have additional questions, including questions about specific types of 
networks, go to www.proseries.com, choose “Help & Support,” then choose “Browse 
Support Articles.”

Workstation access rights
You will be installing ProSeries Express files to a EXPNET04 directory on a shared drive. 
There will also be a PROPDF directory (for the PDF version of any client files that you 
choose to create) on that shared drive.

● Access. Each workstation must be able to access the shared drive or shared folder 
where you will be installing ProSeries Express software.

● Windows NT-based servers. If you’re using Windows NT, Windows 2000, or Windows 
XP (Professional), all users need to be a member of the Administrators group.

● Novell servers. All users need Read, Write, File Scan, Modify, Erase, Delete, and Create 
rights (including access control), but they don’t need the Supervisor Right.

● Peer-to-Peer networks. The network shared folder needs to be set to Full Control.

For more information about access rights and your network, refer to your network vendor’s 
documentation.

Installing ProSeries Express software for network use from 
the ProSeries Express Admin workstation
Important: You install and set up the ProSeries Express program from the ProSeries 
Express Admin workstation first, then you install the ProSeries Express program on each 
workstation as explained in “Installing ProSeries Express software for network use on each 
workstation” on page 60.

When you install ProSeries Express software so multiple workstations can use the program 
in a networked environment, you install the software from the first ProSeries Express CD 
that you receive. Each ProSeries Express CD contains the latest version of each ProSeries 
Express tax product that is currently available.

Tip: For details about each ProSeries Express CD, see “Software service and delivery 
information” on page 25.

Before you install ProSeries Express software for the 2004 tax year, note the following 
information:

● Release Notes. Read the printed Release Notes and any other material that 
accompanied the ProSeries Express CD.
THE RELEASE NOTES MAY CONTAIN, AMONG OTHER THINGS, ADDITIONAL 
LICENSING TERMS THAT GOVERN THE USE OF THE PROSERIES EXPRESS 
SOFTWARE AND RELATED SERVICES.
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● Packing slip. The packing slip that accompanied the ProSeries Express CD contains the 
following information that you will need:
• Your Customer Number and ZIP code
• The install code for ProSeries Express/Network Version

Tip: The only product licensing information that’s printed on the packing slip is your 
Customer Number and ZIP code.

Important: Your network install code is also available in the Order Status and 
Downloads section of My ProSeries.com

To install ProSeries Express software for network use from the ProSeries Express Admin 
workstation, take the following steps:

1 Go to the ProSeries Express Admin workstation.

2 Close all open applications and turn off any virus-protection utilities.

3 Insert the ProSeries Express CD into the appropriate drive.

Don’t remove the CD from the drive until you finish installing products.

4 In the ProSeries Express Installation dialog box, click Tax Preparation.

If the ProSeries Express Installation dialog box doesn’t appear automatically:
a. Go to the Windows taskbar, click Start, then choose Run.
b. In the Run dialog box, type X:\CDSETUP (where X represents the letter of 

the drive containing the ProSeries Express CD), then click OK.
c. When the ProSeries Express Installation dialog box appears, click Tax 

Preparation, then continue to Step 5.

5 In the Welcome dialog box, click Next when you’re ready to continue.

6 A System Warning dialog box appears if the computer doesn’t meet the minimum 
system requirements for the ProSeries Express 2004 software. (For more information, 
see “Computer system requirements for network operation” on page 49.)
If the System Warning dialog box appears, read the information, then do one of the 
following:
• Click Cancel to exit the installation program, then correct the situation(s) identified 

in the System Warning dialog box. After the computer meets the minimum system 
requirements for the ProSeries Express 2004 software, go back to page 55 and start 
the installation procedure again.

• Check the box indicating you understand you may not receive technical support 
for issues that you may encounter while using the ProSeries Express program, then 
click Next to continue to Step 7.

Important: We strongly recommend that you click Cancel and correct the 
situation(s) identified in the System Warning dialog box.

Tip: Go to www.proseries.com for more information about how system requirements 
can affect ProSeries Express operation.

7 In the Software License Agreement dialog box, read the ProSeries Express License 
Agreement to understand the scope of your rights to use ProSeries Express software.
• Select I accept the terms of the license agreement if you agree to accept all the 

terms of the ProSeries Express License Agreement, then click Next and continue to 
Step 8.

• Select I do not accept the terms of the license agreement if you don’t agree to 
accept all the terms of the ProSeries Express License Agreement, then click Cancel 
and exit the installation program.
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Important: If for any reason you find the terms of the ProSeries Express License 
Agreement unacceptable, do not install the software. Contact Intuit for a refund 
instead.

8 In the Select an Installation Type dialog box, select Network, then click Next.

9 In the Setup Type dialog box, select Admin Workstation, then click Next.

10 In the ProSeries Express Networking dialog box, enter the Customer Number and 
Network Version install code printed on your packing slip, then click Next.

11 In the Enter a Name for your Workstation dialog box, enter a name for the current 
workstation (such as “Admin” or the name of the person who typically uses the 
workstation), then click Next.

Select Network to install 
ProSeries Express for 
network use.

Select Admin Workstation 
to install the ProSeries 
Express program on this 
computer, and to install and 
set up ProSeries Express 
network components on a 
shared folder.

You can find this information on the 
packing slip that accompanied your 
ProSeries Express CD.

Your network install code is also available 
in the Order Status and Downloads 
section of My ProSeries.com.
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12 In the Select Local Installation Folder dialog box, do one of the following:

• Click Next if you want to install the ProSeries Express program (for the ProSeries 
Admin workstation) in a \EXPWIN04 directory on the drive that’s shown in the 
dialog box. (That drive will be C: or the drive on which last year’s ProSeries was 
installed.) Proceed to Step 14.

• Click Browse if you want to install the ProSeries Express program (for the ProSeries 
Express Admin workstation) on a local drive other than the drive that’s shown in 
the dialog box. Continue with Step 13.

13 In the Select Folder dialog box, take the following steps:

a. Select the local drive where you want to install the ProSeries Express 
program (for the ProSeries Express Admin workstation).

b. After selecting the drive, type the folder name \EXPWIN04 in the Folder 
name field so that it appears after the drive you selected, then click OK.

c. EXPWIN04 directory. For best results, use EXPWIN04 as the name of your 
2004 ProSeries Express directory. Don’t install ProSeries Express software 
to the root of a drive.

d. If you are prompted to create the EXPWIN04 directory on the drive that 
you’ve selected, click Yes.

e. When you return to the Select Local Installation Folder dialog box, click 
Next. Continue with Step 14.

14 In the Select Network Installation Folder dialog box, click Browse.

Clicking Browse opens the Select Folder dialog box that you will use to identify the 
location to which you want to install ProSeries Express network components. 
Continue with Step 15.

Click here if you want to install the 
ProSeries Express program (for the 
ProSeries Express Admin workstation 
on a local drive other than the drive 
that’s shown.

See Step 13 for additional 
instructions.

Click here to identify the location 
where you want to install the 
ProSeries Express network 
components.

See Step 15 for additional 
instructions.



58 ProSeries Express Edition Quick Reference Guide 2004

Important: If you install ProSeries Express 2004 software to the root of any drive 
and share the whole drive in a Peer-to-Peer network environment, you are giving 
everyone on your network access to all files and folders on that drive.

15 In the Select Folder dialog box, take the following steps:

a. Select the drive where you want to install ProSeries Express network 
components.

b. After selecting the drive, type the folder name \EXPNET04 in the Folder 
name field so that it appears after the drive you selected, then click OK.
EXPNET04 directory. For best results, use EXPNET04 as the name of your 
2004 ProSeries Express directory. Don’t install ProSeries Express network 
components to the root of a drive.

c. If you are prompted to create the EXPNET04 directory on the drive that 
you’ve selected, click Yes.

d. When you return to the Select Network Installation Folder dialog box, click 
Next. Continue with Step 16.

16 In the Tax Year 2004 Product Selections dialog box, select all the products that you 
expect to use for the 2004 tax year, then click Next. (If you used ProSeries software 
for the 2003 tax year, the products that were installed last year may already be 
selected.)

Tip: Every ProSeries Express tax product for 2004 is shown in this dialog box, 
including products that may not be available yet. Select all ProSeries Express tax 
products that you intend to use this tax season. You can install additional products 
later, as described in “Keeping your ProSeries Express products up-to-date” on 
page 62“.

17 If any of the products you selected aren’t on the CD, you’ll see the Installation Note 
dialog box. Review the list of products that will be installed later (when they become 
available), then click OK.

This section 
explains how to 
use this dialog box.

These check boxes are for state products.

These check boxes 
are for federal 
products.

Tip: If you select a 
state product, be 
sure to select the 
corresponding 
federal product.
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18 In the E-mail Alert Registration dialog box, click Accept or Decline, depending on 
whether or not you accept the terms of the E-mail Alerts system, then click Next.
Tip: E-mail alerts inform you when the products you selected for installation become 
available or are updated. They also inform you about support issues and present 
information relevant to your ProSeries Express products.

19 Review the E-mail Alert Selection on Multiple Computers dialog box, then click OK.

20 In the Disk Space Confirmation dialog box, review the Required Space and Available 
Space information, then click Next.
The installation program installs all available ProSeries Express tax products that you 
selected, then verifies that all applicable files were installed correctly.
Installation Failed dialog box. If you see this dialog box, a product was not installed 
properly. Click Help to find a possible solution, then click Exit to exit the installation 
program.

21 Additional components. Wait while additional components, such as any necessary 
fonts, Internet Client software, the ProSeries Express User’s Guide, WexTech® 
AnswerWorks® software, and ProSeries Express Product Licensing components are 
installed. Dialog boxes and progress bars keep you informed.

Tip: The User’s Guide is installed automatically. WexTech AnswerWorks is the search 
engine that powers the Search Help feature.

22 Internet Explorer. If Microsoft Internet Explorer 5.5, service pack 2 or later isn’t 
installed on your computer, the installation program installs Internet Explorer 6.0 
before continuing. ProSeries Express software requires portions of Internet Explorer 
5.5, service pack 2 or later to run properly.

23 Restart Windows message. Restart the computer if you are prompted to do so.

If the installation program doesn’t resume after you restart the computer, 
start the ProSeries Express program by double-clicking the ProSeries 
Express Edition 2004 shortcut icon on the Windows desktop. The 
Connected Customer Wizard will begin automatically. Go to “Setting up the 
ProSeries Express program” on page 12.

24 Setup Complete. In the Setup Complete dialog box, click Finish.

25 If the Launch ProSeries Express Edition option was selected: The Connected Customer 
Wizard begins for the ProSeries Express Admin workstation. The Options Setup 
Wizard begins for other workstations. Proceed to “Setting up the ProSeries Express 
program” on page 12 now.
If the Launch ProSeries Express Edition option wasn’t selected: You return to the 
ProSeries Express Installation dialog box that’s discussed in Step 4 on page 55. Click 
Exit to return to the Windows desktop. Continue with Step 26.

This is the directory from which you 
install the ProSeries Express program on 
each workstation.

We strongly recommend that you leave 
the Launch ProSeries box checked.
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26 After you return to the Windows desktop, start the ProSeries Express 
program by double-clicking the ProSeries Express Edition 2004 shortcut 
icon.
The Connected Customer Wizard will begin.

27 Continue with “Setting up the ProSeries Express program” on page 12.

Setting up the ProSeries Express program from the 
ProSeries Express Admin workstation
Important: The ProSeries Express program should start from the ProSeries Express Admin 
workstation the first time. Don’t install ProSeries Express software on other workstations 
until you’ve set up ProSeries Express from the ProSeries Express Admin workstation.

The first time that you start the ProSeries Express program, the Connected Customer 
Wizard helps you set up the program if you have a valid Internet connection.

The Options Setup Wizard starts automatically if you choose the Edit button in the Prior 
Year Settings Transferred dialog box. The wizard helps you set ProSeries Express options.

Next, you are asked if you want to transfer last year’s client files. The transfer procedure is 
a simple way to start your clients’ ProSeries Express 2004 client files using the relevant 
data in their ProSeries 2003 client files.

Tip: Current-year client files are stored in the Primary File Location, and the default setting 
for the Primary File Location is the \04DATA directory within the \EXPNET04 directory.

Installing ProSeries Express software for network use on 
each workstation
After you’ve finished installing and setting up the program from the ProSeries Express 
Admin workstation, take the following steps to install the ProSeries Express program on 
each computer that will be used as a ProSeries Express workstation.

To install the ProSeries Express program for network use on a workstation:

1 Log on to the workstation, then start Windows Explorer.

2 In Windows Explorer, find the shared drive where the ProSeries Express network 
components are installed.

3 Find the ProSeries Express directory on the shared drive.

Tip: The ProSeries Express directory is \EXPNET04 if the recommended name was 
entered during the installation of ProSeries Express software from the ProSeries 
Express Admin workstation.
The Setup Complete dialog box that appears when you install ProSeries Express 
software from the ProSeries Express Admin workstation identifies the name of the 
ProSeries Express directory.

4 In the ProSeries Express directory, find the \WKSTN directory.

5 Double-click the SETUP.EXE file in the \WKSTN directory.

6 Follow the instructions on the screen.

Tip: There are fewer dialog boxes for a workstation than there are for the ProSeries 
Express Admin workstation.
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7 When prompted, enter a name for the workstation to identify it to users at other 
workstations.

8 When the Select Destination Directory dialog box appears, do one of the following:

• Click Next if you want to install the ProSeries Express program (for the current 
workstation) in a \EXPWIN04 directory on the local drive that’s shown in the 
dialog box. (That drive will be C: or the drive on which last year’s ProSeries was 
installed.)

• Click Browse if you want to install the ProSeries Express program (for the current 
workstation) on a local drive other than the local drive that’s shown in the dialog 
box.

Important: Don’t select the location where ProSeries Express components are located.

Important: Repeat Step 1 through Step 8 for each computer that will be used as a 
ProSeries Express workstation.

Installing ProSeries Express software on a workstation from a
ProSeries Express CD
It’s recommended that you install the ProSeries Express program on each workstation as 
explained in “Installing ProSeries Express software for network use on each workstation” 
on page 60. However, if you are unable to install the ProSeries Express program on a 
workstation from Windows Explorer using the SETUP.EXE file, you can install the program 
from the ProSeries Express CD.

1 Go to the workstation, close all open applications, and turn off any virus-protection 
utilities.

2 Insert the ProSeries Express CD into the appropriate drive.

Don’t remove the CD from the drive until you finish installing products.

3 Follow the instructions on the screen. The installation procedure will be similar to the 
installation procedure for the ProSeries Express Admin workstation (see page 55), but 
note the following exceptions:

• In the Setup Type dialog box, select Workstation (Don’t select Admin Workstation).
• In the Select Network Installation Folder dialog box, click Browse, then locate the 

shared folder on your network to which ProSeries Express network components were 
installed from the ProSeries Express Admin workstation.

Click here if you want to install the 
ProSeries Express program (for the 
current workstation) on a local drive 
other than the drive that’s shown.
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Keeping your ProSeries Express products up-to-date
You can use the following methods to update products that were previously installed and 
to install products that haven’t been installed yet.

Task Scheduler
The Task Scheduler program can keep your ProSeries Express tax products up to date 
automatically.

1 Go to the ProSeries Express Admin workstation and start the ProSeries Express 
program.

2 Go to the Tools menu, choose Options, then select Task Scheduler.

3 Make sure the Download New/Update Existing Products task is enabled.

Important: When Task Scheduler installs a new ProSeries Express tax product or updates 
an existing ProSeries Express tax product on the shared drive, that new product or product 
update becomes available to all the workstations on which the ProSeries Express program 
is installed for network use.

To see more information about Task Scheduler after you finish setting up the program, use 
the Search Help feature on the Help pane, or go to the Help Center and click User’s Guide, 
then go to chapter 8, “Using Task Scheduler.”

ProSeries Express Help menu
You can initiate the product-update and product-installation procedures from the ProSeries 
Express Help menu.

1 Go to the ProSeries Express Admin workstation and start the ProSeries Express 
program.

2 Go to the Help menu and choose Update Installed Products/Download New Products.

3 If you want to select additional products for installation, click the Choose Products to 
Install button, then select those products.

Important: When the Update Installed Products/Download New Products procedure 
installs a new ProSeries Express tax product or updates an existing ProSeries Express tax 
product on the shared drive, that new product or product update becomes available to all 
the workstations on which the ProSeries Express program is installed for network use.

To see more information about the Update Installed Products/Download New Products 
command, use the Search Help feature on the Help pane, or go to the Help Center and click 
User’s Guide, then go to chapter 1, “Installing ProSeries Express.”

ProSeries Express CDs
You can update installed products and install new products from ProSeries Express CDs 
that you receive in the future, using the installation program on the ProSeries Express CD.

1 Go to the ProSeries Express Admin workstation and make sure the ProSeries Express 
program isn’t running.

2 Insert the ProSeries Express CD into the appropriate drive of the ProSeries Express 
Admin workstation.

3 Follow the installation instructions on the screen.



Network Installation 63

4 If you see the Updates Available dialog box, click Update.

If you see the All Products are Up-To-Date dialog box, click Exit.

5 Go to a workstation on which the ProSeries Express program was installed for 
network use and make sure the ProSeries Express program isn’t running.

6 Insert the ProSeries Express CD into the appropriate drive.

7 Follow the installation instructions on the screen.

8 If you see the Updates Available dialog box, click Update.

If you see the All Products are Up-To-Date dialog box, click Exit.

9 Repeat Step 5 through Step 8 for each additional workstation on which the ProSeries 
Express program is installed for network use.

Important: When you update installed products and install new products from ProSeries 
Express CDs that you receive, you must run the installation program (on the ProSeries 
Express CD) from the ProSeries Express Admin workstation before you run it from each 
workstation on which the ProSeries Express program was previously installed for network 
use.

To see more information about installing and updating ProSeries Express tax products 
from ProSeries Express CDs, use the Search Help feature on the Help pane, or go to the 
Help Center and click User’s Guide, then go to chapter 1, “Installing ProSeries Express.”

Troubleshooting suggestions
If this situation occurs... Do this...

You are unable to find the 
\WKSTN directory, and the 
drive where you installed the 
ProSeries Express software is 
mapped

1. Double-click My Computer on the desktop.

2. If the mapped drive has a red X, contact your network 
administrator for help verifying the network connection.

3. Double-click the mapped drive in the My Computer dialog box.

4. Double-click the \EXPNET04 directory, then locate the \WKSTN 
directory.

You are unable to find the 
\WKSTN directory, and the 
drive where you installed the 
ProSeries Express software is 
NOT mapped

1. Double-click Network Neighborhood or My Network Places on 
the desktop.

2. If the server does not show up in a window, contact your 
network administrator for help verifying the network 
connection.

3. Double-click the server icon.

4. Double-click the shared folder where you installed the 
ProSeries Express software.

5. Double-click the \EXPNET04 directory, then locate the \WKSTN 
directory.

The installation program 
didn’t start when you 
double-clicked the 
SETUP.EXE file

1. If the workstation is running any Windows operating system, 
press CTRL-ALT-DEL. 

2. Look for SETUP in the Close Program dialog box. If SETUP is 
listed more than once, highlight one SETUP and select End 
Task.

3. Repeat these steps until only one SETUP is listed in the Close 
Program dialog box.
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A dialog box informs you 
that the computer doesn’t 
have enough disk space

1. Go to the Start menu, point to Programs, then Accessories, then 
System Tools, and then click Disk Cleanup.

2. Try to install the ProSeries Express software again.

3. If there still isn’t enough disk space, remove unused programs 
or data from the hard drive.

A dialog box informs you 
there was an error

1. Write down the error message, then restart the computer.

2. Go to the Start menu, point to Programs, then Accessories, then 
System Tools, and then click ScanDisk.

3. After ScanDisk is complete, go to the Start menu, point to 
Programs, then Accessories, then System Tools, and then click 
Disk Defragmenter.

4. After Disk Defragmenter finishes, run your virus-protection 
software.

5. Try to set up the workstation again.

6. If you aren’t receiving the error message at other workstations, 
continue setting up those other workstations.

You can’t install the Express/
Network Version software 
from the computer you’ve 
chosen to be the ProSeries 
Express Admin workstation

If you haven’t installed the ProSeries Express software and there’s 
another computer on the network that can function as the 
ProSeries Express Admin workstation, try to install the ProSeries 
Express software from that computer.

The ProSeries Express 
program doesn’t start when 
it should

1. Restart the computer.

2. Make sure no other applications are running.

3. Double-click the ProSeries Express Edition 2004 icon on the 
desktop.

You still are unable to set up 
the workstation or start the 
ProSeries Express program

Start your Internet browser, then go to www.proseries.com to 
search for additional troubleshooting solutions.

You are unable to resolve the 
problem

Call ProSeries Express Technical Support at 1-800-434-6818. To 
save time, gather as much information as possible, and have your 
network administrator available.

If this situation occurs... Do this...


